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Warranty Statement 
There are no warranties, express or implied, with respect to the contents of this document, and all information provided 
herein is provided “as is.” Osteoid reserves the right to periodically change the information that is contained in this 
document; however, Osteoid makes no commitment to provide any such changes in a timely manner or at all. 

Limitation of Liability 
In no event shall Osteoid or its affiliates be liable to any party for any direct, indirect, special, or consequential damages in 
connection with your use of this document, including, without limitation, loss of business revenue or earnings, lost data, 
damages caused by delays, lost profits, or a failure to realize expected savings, even if Osteoid was expressly advised of 
the possibility of such damages. 

End of Life Statement 
Osteoid is committed to the continuous improvement of InvivoVet by utilizing state-of-the-art technology and 
trends to provide the most comprehensive software for the diagnoses of patients. The “shelf life” of InvivoVet 
software has been defined as 3 years from the release to ensure the highest level of patient care and safety. 
Notification of software improvements and new releases will be provided to customers to update to the latest 
version. Previous (older) versions may continue to be utilized, but support may be limited and the software may no 
longer receive security patches or software updates. If the device remains in service following the end of support, 
the cybersecurity risks for end-users can be expected to increase over time.  

Trademarks 
Osteoid and related marks, images, and symbols are the exclusive properties of, and trademarks of, Osteoid Inc. All other 
brands and marks are the properties of their respective owners. 

Copyright 
Documentation for InvivoVet and the operating software are copyrighted with all rights reserved. Under the copyright 
laws, this documentation may not be reproduced, transmitted, transcribed, or translated into any human or computer 
language in whole or part without the prior written permission of the copyright holder. 

Language 
The original language of this manual is English. Other versions are available. Please contact Osteoid for other 
language versions.  

Intended Use 
InvivoVet is a software application used for the display and 3D visualization of veterinary imaging files from 
scanning devices, such as CT, MRI, or 3D Ultrasound. It is intended for use by veterinarians, radiologists, and 
other qualified individuals to retrieve, process, render, review, store, print, assist in diagnosis and distribute 
veterinary imaging files. 
  
Limitation of Use 

• InvivoVet is not a medical device under EU MDR 2017/745, FDA 21 CFR 801.3, or equivalent human 
medical-use regulations. 

• InvivoVet is not intended for human diagnostic or therapeutic purposes. 
• The software does not perform automatic diagnosis, nor does it replace the professional judgment of a 

licensed veterinarian. 
 
Intended Patient Population 
All animal species. Not intended for humans. 
 
Intended User 
InvivoVet is designed to be used by licensed veterinarians, veterinary technicians, imaging specialists, and other 
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professionals who have been appropriately trained to use 3D CT imaging devices and read the image data 
generated by the devices. 
 
Measurement Accuracy 
InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, measurement 
accuracy depends on the image data and the hardware scanner that generated the image data. The measurement 
cannot be more precise than the resolution of the image. Software reports the value based on user-picked points. 
Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends on 
the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 

Required Training 
Prior to any applications using InvivoVet, user is recommended to take training and practice for the following 
content: 
View digital image in 2D and 3D; image operations such as pan, zoom, brightness/contrast adjustment. The user is 
recommended to contact Osteoid technical support for a full software training at 408-333-3484 ext. 4. 
 
Security Recommendations 

• Restrict access by requiring a username and password in operating system security settings. Only assign 
login credentials to trusted individuals within your organization. Refer to operating system website or 
customer support for instructions. 

• Ensure that system restore and backup functionality is enabled. The ability to toggle system restore and 
backup should be restricted to system administrators.  

• Enable multi-factor authentication where possible. 
• Use cybersecurity controls such as a firewall, anti-virus, anti-malware, etc. 
• InvivoVet requires internet access for license verification. Ensure that the network you will be using with 

the software is secure.  
• To set up the controls recommended above, contact your internal IT team, operating system manufacturer, 

internet service provider (ISP), modem/router manufacturer, or refer to manufacturer 
website/documentation. 

• Customers who purchase and use InvivoVet are ultimately responsible for the implementation of safe and 
secure practices for the protection of patient data. 
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Introduction 
InvivoVet Imaging Software 

teoid, Inc. is a medical imaging company composed of a cross-
functional team consisting of the most elite researchers, 
mathematicians, engineers, software developers, business 
analysts, industry leaders, academic faculty, and imaging 

specialists. We believe that InvivoVet software will empower veterinary 
professionals to advance the practice of animal care through the use of 
modern 3D imaging and visualization tools.  Our mission with InvivoVet 
is to develop simple, refined, and powerful software designed specifically 
for veterinarians—enabling them to harness the most advanced imaging 
and planning technologies to better diagnose, plan, and treat their animal 
patient. With InvivoVet, clinicians can reconstruct and visualize 3D 
anatomical structures directly on their computers, review cross-sections, 
trace anatomical pathways, plan surgical procedures, print and save images, and perform many additional functions. The 
software reconstructs 3D volume renderings from DICOM files generated by CBCT, medical CT, and MRI systems 
commonly used in veterinary imaging. InvivoVet is intended for use as a planning and simulation software to assist in 
veterinary diagnostics, surgical planning, and treatment evaluation across a variety of species. 

his manual is intended to provide supplementary information to your direct training with the Osteoid support team. 
For correct and safe use, training is highly recommended.  

 

O 

T 
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System Requirements 
Below are the minimal and recommended system configurations. 

aving an adequate computer system is essential to using InvivoVet efficiently and generating the highest quality 
images possible for enhanced analysis and presentation for your patients and colleagues. The most important 
element is the video card (3D graphics chip or GPU). If your system does not have an appropriate video card, 
you can purchase and install video cards for desktop computers. 

InvivoVet has minimal system requirements; however, Osteoid recommends the following configurations to fully utilize 
all the features within the InvivoVet Software.  

Summary 
 

Minimum Recommended 
CPU Intel Core i3 series Intel Core i7 (Gen8) or comparable multi-core 

processor 
RAM 8GB 16 GB 
GPU / Graphics Card See Graphics Cards table below See Graphics Cards table below 
Hard Disk 100GB 500GB+ SSD 
OS Windows 11 64-bit Windows 11 Pro 64-bit 

 

Mac Users 

 OS Hardware 
Not Compatible MacOS 12 and earlier, Parallels 2019 and earlier 

Fully Compatible 
Apple Bootcamp (requires a full license of 

Windows) 
MacOS 13 and later 

2020 and later 

Note: For optimal visualization, the monitor display scale should not exceed 150 percent. 

Graphics Cards / GPU Details 

Brand Model Series Low-End Options High-End Options 

AMD RX Series 
Pro Series 

RX 5000 
Pro W5000  

RX 9000 XT 
Pro W7000 

Nvidia GeForce 
Quadro  

RTX 2000 Series 
Quadro RTX A Series 

GeForce RTX 5000 Series 
Quadro RTX Pro 

 

  

H 
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Installing InvivoVet 
About the License Types 
Invivo Workspace Account 
A free Invivo Workspace account is required to activate and manage your licenses. Invivo licenses are assigned to your 
user account using your email as your username. To create an account, visit www.invivoworkspace.com.  

Assigning a license (Perpetual) 
As an admin, find your email username in the Organization list. In the Information Panel, toggle on the license you want 
associated with your account. This applies to Add-on licenses as well. 

 

Note: Users who only have single person in their organization will have their licenses automatically assigned to them. 

Licensing Support 
User can find knowledge base articles about licensing at the Osteoid help center: https://learn.osteoidinc.com  

Activity History/Auditing 
Admins and Users can see activation history by: 

• Users: My Products section> Select corresponding product > Click Manage License/Activity History in 
the Info Panel. 

• Admins: Admin section > Select corresponding product > Click Manage License/Activity History in the 
Info Panel. 
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Internet Requirement 
Internet is required when signing in or signing out of Invivo. During usage, if the computer loses connection to the internet, 
at minimum, a 12-hour grace period starts. If the computer is not connected to the internet within that time, Invivo will be 
unavailable for use until the connection is restored. 

 
Website Installation Instructions 

1. Login into your Invivo Workspace account at www.invivoworkspace.com.  

2. Click on the My Products tab. 

3. Select the respective product (ie. Invivo Desktop , Invivo Ultimate, etc.) 

4. In the Information Panel, click on the “Download” link 

5. Download the latest installer 
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Validating the Installer File 
 
1. Right-click the Installer file and select “Properties” to open the Properties window. 

2. Open the “Digital Signatures” Tab. 

3. Select “Anatomage, Inc.” and press Details. 

4. Verify that the Digital Signature Information is “OK.” 

 
The following pictures are for demonstration purposes only. The name of the installer and Digital Signature Information 
is dependent on the release version and may change accordingly.  

   
 
InvivoVet Setup Wizard 
 

Click Next to 
continue. 
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Installation Preferences: The user can specify the folder for software installation as well as the level of 
functionality with which the software initially opens.  

 
 
Review the End-User License Agreement and 
accept the terms if desired to proceed with the 
installation. 

 

 

Click Next to continue. The program proceeds with installation until completed. Click Finish to close the wizard. 
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Launching Invivo / Signing into Invivo 
Please be connected to the internet when starting Invivo. 
 
In-App Login 

1. Launch Invivo 
2. During the Splash Screen, you’ll be presented with the Sign-in Screen. 

a.  
3. Type in your login credentials. If you have not created an account yet, please click “Create Account” and 

follow the instructions to do so and launch Invivo again. 
4. If you prefer to login with your Google or Facebook account, please refer to the next section titled “Web Browser 

Login.” 
 
Web Browser Login 

1. Within the Sign-in Screen, click on the “Continue with Google” or “Continue with Facebook” button. 
2. Your internet browser will launch and be directed to the Invivo Workspace login page. 
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a.  
 

3. Type in your login credentials for Invivo Workspace. If you are signing in with Google or Facebook, click 
on the corresponding button and enter the respective credentials. If you have not created an account yet, 
please follow the instructions to do so and launch Invivo again. 

4. After entering your credentials, a permission dialog will appear. 

a.  
b. It is highly recommended to click “Always Allow” to improve launching Invivo in the future. 

Otherwise you’ll need to provide permissions every time you login. 
5. After clicking “Open Link”, Invivo will launch. 
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a.  
 
 
Selecting a License 
If your account has been assigned multiple license types, you’ll be presented with a license selection screen. You 
can select between your assigned subscription and perpetual licenses. If you have add-ons with your perpetual 
licenses, you’ll also be provided the opportunity to select those to activate as well. Licenses are identified with the 
last four characters of that license’s product code. 
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Migrating or Transferring a License / Signing out of Invivo 
To use the license of Invivo on another computer, the license must be deactivated from the current computer. This can be 
accomplished by signing out of the Invivo software. Once signed out, the license will be available to be activated on 
another machine by following the Sign In process.  
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Feature List 
An overview of the various features provided by Invivo. 

• Directly Opens DICOM Data from Any CT Machine 
 

• Invivo File Compression 
 

• Section and Multislice View Operations 
 

• Volume Rendering of Scan Data 
 

• Linear, Angular, Circumferential, Area, and Volumetric Measurements* 
 

• Image Capture and Export 
 

• AVI (Movie) Capture and Export 
 

• Bone Density Evaluation 
 

• Quick Airway Volume Measurement and Evaluation 
 

• Automatic Superimposition and Mirroring 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
*All measurements are performed with the metric system. 
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Software Layout 
The following is a description of how Invivo is organized by Menu Bar, Toolbar, View Tabs, View Control 
Panel, and Rendering Window. 

 

 

 

 

 

 

 

  
Control Panel 

The Control Panel is the region 
where patient images can be 

manipulated and controlled.  The 
Control Panel is associated with 

a specific View Tab. 
 

Rendering Window 
Rendering Window is the region 

where patient images are 
displayed.  This window can be 
customized within many of  the 

View Tabs by using the Toolbar. 

View Tabs 
The View Tabs 

perform specific tasks 
or look at specific 

subjects of  interest by 
adjusting the Toolbar 
and View Controls. 

 
 
 
 

Menu Bar 
The Menu Bar 

contains application 
operations such as 
open, save, close, 
print, capture, etc. 

 

Toolbar 
Tools can be accessed to 

perform certain functions on 
patient images.  Sets of  tools are 
associated with a specific View 

Tab. 
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Invivo Preferences 
This section explains the different options within the Preference window of Invivo. The Invivo preferences 
include options for Display settings, Volume Rendering settings, as well as File Manager settings. 

Accessing the Invivo Preferences: 
• In the Menu bar of the Invivo, select “File.” 
• Select “Preferences…” from the “File” drop-down. 

 
Display Preferences 

 

 

GUI Settings 
• Background: Sets the background color for the 

rendering window. 
• Measurement Font Size: Sets the measurement 

font size to a size preset: small, medium, or 
large. 

• Measurement Text Color: Sets the text color 
for measurement notations. 

• Measurement Line Width: Sets the width for 
measurements. 

• Measurement Line Color: Sets the color of the 
measurement lines. 

• Tag Text: Provides an additional label to the 
right-hand corner of the rendering window. 

• Date Format: Current date format for case 
information display. 

• Continuous view: 
o Checked – Switching between view 

presets for volume renderings shows 
intermediate volume positions.  

o Unchecked – Switching between view 
presets does not show intermediate 
positions; the volume “jumps” to the 
final position. 

 
• Make text annotations global: When checked, previously placed or new text annotations added to any 2D 

slice view except group slices (TMJ, Arch) are visible when scrolling past the slice the measurement was 
placed on. 

• Cycle 2D distance measurement color: Measurement colors cycle with every measurement that is added. 
• Enable multiple distance measurement mode: Distance measurement becomes a toggle on/off button for 

measurement mode. Toggling “on” this mode continuously picks beginning and end points for linear 
measurements with each click after the first measurement has been created until toggled “off.” 

Color Theme:  
• Two color themes are available for the software.  
• The software images in this manual are in Dark mode, but the overall functions are shared between the 

themes. 
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Auto save 2D view setting on application exit 
• This setting determines if 2D view settings made in each of the applicable tabs are saved automatically 

upon program closure and be reloaded with the next opened case. If left unselected, the user has to 
manually save the configuration by clicking Save View Settings in the working tab. The specific 2D view 
settings that are saved in each tab are given in the table below: 

 
2D Section Rendering presets, custom Brightness/Contrast (if the 

Dental preset is chosen), Sharpen Filter, Volume 
Clipping, Slice Thickness 
 

Arch Slice Interval, Cross Section 
Width/Interval/Thickness, Auto R-L, Pano Image 
Type, Pano Ruler Enabled, Brightness/Contrast 
mode, Layout (including Axial vs. Cross Series and 
Print Layout), Sharpen Filter, Color Preset, Nerve 
Diameter, and Nerve Visibility 
 

TMJ Lateral Width/Interval/Thickness, 
Brightness/Contrast mode and settings, Layout 
(including sequence type and Print Layout), Sharpen 
Filter, Color Preset, Focal Trough Thickness and 
Symmetry, Frontal Render Mode 
 

Airway Rendering presets, custom Brightness/Contrast (if the 
Dental preset is chosen), Sharpen Filter, Volume 
Clipping, Slice Thickness 
 

Endo Rendering presets, custom Brightness/Contrast (if the 
Dental preset is chosen), Sharpen Filter, Volume 
Clipping, Slice Thickness 
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Volume Rendering Preferences 

 

 

Volume Rendering View Settings 
• Quality Resolution: Sets the limit for the 

resolution of the image. This can be set to 
either a user-defined number or set to 
Unlimited. 

• Initial Rendering: Sets the rendering 
quality upon opening Invivo. 

• Shaded Slice Sampling Rate: Accepts a 
numerical value that sets the sampling rate 
to improve image quality at the cost of 
performance. 

• Use lower resolution while moving 
volume: Positional changes of the volume 
are rendered at a low-quality resolution 
while maintaining the quality resolution 
setting in the final position. 

Volume Rendering Range 
• The user can define the range of 

Hounsfield Units that are rendered. This 
cannot be set when “Use automatic H.U. 
range” is checked.  

• Checking “Non-CT modality: use scalar 
for min-max” allows the user to define the 
minimum and maximum scalar units that 
are rendered. 

Material 
• Various properties can be adjusted to change the appearance of a volume rendering. Ambient, Diffuse, and 

Specular effects can be rendered in different colors. 
• The degree of Emission and Diffuse can be adjusted with the respective sliders. 
• Shininess is set to a number – higher numbers denote less shininess. 
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File Manager Settings 

File Type-Associated Folder Paths 
Folder paths can be set for each of the Invivo and DICOM file type options. When one mode is selected, the program 
uses the file paths associated with that file type mode, but the user may still save or open either file type at any time. 
 
File Path Preferences for Different Users 
In the situation that there are multiple users on a single computer with Invivo7 installed across multiple user 
accounts, the file paths for all new accounts initially take on the preferences defined by the user administrator 
account. Non-admin accounts may redefine their file path settings, but they will be overwritten the next time the 
settings are changed on a user administrator account. 
 

   

File Paths 
• Osteoid Case Path: This folder serves as a 

backup folder for all opened cases from the 
locations selected in the Copy Files to Osteoid 
Case Folder Before Open. 

• Default Open Path: This is the starting location 
for attempting to open a case through File → 
Open in the Menu bar. 

• Default Save Path: This is the starting location 
for saving a case file in Invivo. 

• Temporary File Path: This is the temporary 
location that the Capture To File In Temporary 
Folder function uses. 

Copy Files to Osteoid Case Folder Before Open 
• This section allows the user to save a copy of a 

case that is to be opened in the Osteoid Case 
Folder if it is in any location besides this folder, 
such as on a different location on a network, on 
a CD-ROM, or in a different folder on the local 
hard drive. 

DICOM Advanced Settings: Change Character Set 
• This option is only available if the DICOM File option is selected. 
• Import 

• If checked, this sets the value for the Specific Character Set DICOM tag (0008, 0005) 
o When Missing: This will use the specified value only when the tags are missing 
o Always: This will always use the specified value on import 

• Export 
• If checked, this sets the value for the Specific Character Set DICOM tag (0008, 0005) on export. 

 

   Warning: Importing or Exporting with the incorrect Character Set could lead to unreadable text.  
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PACS Settings 
 

 

Import Configuration 
• Configure: Click to edit the server and client 

information from which cases are imported. 

Export Configuration 
• Configure: Click to edit the server and client 

information to which cases are exported. 
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Module Settings 

 

 

Server Path 
• Enabling this dialog allows the admin 

user to set the directory for data export 
within the software. 

o This option is only available 
when running the software as an 
admin. 
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Admin Settings 

These options are only available when running the software as an admin. 

 

Display – GUI Settings 
• Enable restricted access mode: 

Toggling “on” this option restricts the 
standard user from modifying software 
display preferences. 

File Manager – Change Default File Paths 
• Admin Only: Toggling “on” this option 

restricts the standard user from 
modifying software file paths. 

PACS - Configuration 
• Admin Only: Toggling “on” this option 

restricts the standard user from 
modifying PACS configurations. 

• Modes 
o Standard: Files can be opened from 

or saved locally and onto PACS 
through the PACS user interface.  

o Full PACS: Disables opening or 
saving files locally. Only select this 
option if a PACS is in place. 

o Export PACS Only: Disables saving 
files locally. Only select this option if 
a PACS is in place. 

Audit Logging 
• Enable: Toggling this “on” enables logging user activity on this computer. The following activities are 

logged: 
o Software Application Login Attempts 
o Software Application Launches and Closes 
o File Open and Saves 

• Log Type 
o Default: The log is stored in a text file at the specified path. 
o Password Protected: Enter a password. The log is stored in an encrypted password-

protected file at the specified path. 
• Change Log Path: Specify the location of the log. 
• Export Password Protected Log: Enter the password to decrypt the password-protected log file. A text 

file will be generated at the specified location. 
 
The “OK” button must be pressed in the Preferences dialog for changes to be accepted at any stage. 
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Basic Features 
The following is a detailed explanation of the various features provided by Invivo. 

DICOM & Invivo File Loading with the File Manager 
  
To open a DICOM data set or Invivo-associated file type (.inv, .amg, apj), first launch the Invivo software. The File 
Manager appears upon startup for loading the scan data. If one of the PACS mode options in Preferences was 
selected, please refer to page 31. 
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Click the Browse File from This Device button 
to search manually for local data to open. For 
opening DICOM data, as shown to the right, 
simply highlight one of the .dcm files and click 
Open. It does not matter which DICOM file 
is chosen, as selecting one opens all the files 
within the data set present in that folder. For 
opening an Invivo file, select it and press Open. 
Invivo files can also be compressed and opened. 
 

 
The File Manager automatically stores recently viewed case locations. This allows for quicker access to these cases. 
By default, files are saved in the “Osteoid Cases” folder, located in “My Documents.” This location can be changed 
in the Menu Bar → File → Preferences → File Manager. 
 
Quickly search through the recent cases by 
typing in the Patient Name or Scan Date in the 
search fields (shown right). The selected cases 
can be removed from the Recent Case List by 
selecting the Options... button and using the 
additional buttons (shown below). These 
options can completely clear the Recent Cases 
list. 
 

 

Click the Browse File from The Invivo 
Workspace button to search cases available on 
Invivo Workspace. Available cases are 
displayed in the File Manager to be loaded into 
Invivo. Files are nested under the Case ID. 

 
 
After closing a case, to reopen another one, click on “File” → “Open”, and the File Manager will appear again. 
 
Selecting Options… displays additional options to delete the recent case history or to delete select cases from the list. 
This only modifies the cases that are displayed on the File Manager and does not delete the actual files from where 
they are saved. 
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Invivo/DICOM File Saving 

Invivo provides four options for saving and each type differs in the 
size of the saved file and its compatibility with other software. 
Choosing “File” → “Save As...” for any file presents the dialog on 
the right. Choosing “File” → “Save” when a DCM file is open 
saves an INV in the specified location or simply overwrites the 
same file if it is already in INV file type.  

 
Invivo 
The following work can be saved as an Invivo file 
(.inv).  

• Case Information & Patient Orientation 
• Traced Nerves 
• Volume Measurements, Landmarks, and 

Annotations 
• Images captured within the Gallery 
• Sculpting Operations 
• †Models imported from MDStudio 

 
†These functions require the installation and activation of additional 
software modules. 
 

 
Click “File” → “Save As...,” browse to the 
destination folder, name the file (default is the 
patient’s name), then click Save. 
 
The following save dialog box appears. Select the 
default “Full” option for saving everything without 
losing any information. 
 

 
DICOM  
When the DICOM file type is chosen, the output 
options are either a single lossless DICOM or a multi-
file DICOM (with DICOMDIR) accompanied with 
an Invivo workup file containing workup data and a 
folder of exported Gallery images in DCM format.  
 
For single-file DICOMs (Figure 1), the save dialog 
asks for a location to save the files. For multi-file 
DICOMs (Figure 2), create or choose a folder to save 
the slices and DICOMDIR file. The DICOMDIR file 
presents the directory of slices to Invivo to accelerate 
the loading speed. 
 

 
Figure 1: Single-file DICOM Save Dialog 

The DICOM File Save Option dialog (Figure 3) presents numerous options for saving the file. Compression 
reduces the size of the file at the cost of increased saving and loading speed. “Lossless” or “Lossy” determines 
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the quality (amount of data) of the file that is saved. Resampling changes the resolution by a factor in each 
orthogonal plane. The workup file description can be used to differentiate between different workup files on 
PACS. If “Save additional series” option is selected, the coronal and sagittal DICOM series are also exported 
along with the default axial series. 
 

 
Figure 2: Multi-file DICOM Save Dialog 

 

 
Figure 3: DICOM File Save Options 

Custom Saving Dialog 

Available for Invivo file saving: By selecting the “Customize” option, 
the custom saving dialog shows up. In the dialog box are data 
compression options. For the main volumetric image, “Lossless” or 
“Lossy” compression options are available. With lossless compression, 
the volume is compressed to about 1/3rd – 1/4th of the original size. With 
the Lossy compression option, the file size can be dramatically reduced, 
but the image is altered. Resampling the data greatly reduces its size by 
combining voxels to reduce the overall voxel count. Rescaling the image 
reduces the number of shades of gray in the image. Options to selectively 
compress images in the Gallery, the clinical content (such as implants 
and nerve tracings), and the models can be selected.  

 

 
Warning: Saving files in lossy format degrades image quality. 

 
Saving As an Invivo Project File 

Click “File” → “Save As Project...” to save the case as an APJ, Invivo Project file. This file only saves work up data. It 
requires a reference data (.dcm scan data or .inv file) when opening. If Invivo cannot locate the reference data, it prompts 
to locate the data filepath. Because it is saving only the changes to the original, APJ files save much faster than full INV 
files. 

DICOM File Loading with PACS 

If one of the PACS option in the Preferences of Invivo were chosen, upon launch, the PACS File Import window opens 
instead of the File Manager. At initial launch, the settings need to be configured to connect with the database, but this 
information is retained subsequently. 
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Without selecting a PACS mode, this interface can still be accessed by choosing “File” → “Import PACS.” 

PACS Configuration 

Click Configure to set up the connection to PACS. Input 
the appropriate server data and test the connection to 
verify the information. Tag configuration and Query and 
Retreive settings can be accessed under Configure Tags. 

Configurations can be added, updated, and removed from 
the drop-down menu. 

Scans from PACS are stored locally in the Local Storage 
Directory folder while they are open. The option to delete 
the local files after opening them is available. 

Transport Layer Security (TLS) setup can also be 
configured. 

Once the information is complete, click OK. This data is 
saved until manually reconfigured. 
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PACS File Loading 

Click Query to load the cases stored on PACS. Filter cases using the patient information fields. Select a case from the 
Case List and click OK. Invivo searches for any workup files associated with the patient. Select an existing workup file 
and click OK or click Cancel to open the raw patient scan. 

s 

PACS File Saving 

Click on File →  “Export PACS” to save the file onto PACS.  
• Configure: Opens the PACS Configuration dialog. 
• For descriptions of the different DICOM types, refer to page 30. 
• Without installing under PACS mode, this interface can still be accessed by 

choosing “File” →  “Export PACS.” 
 

 

Export DICOM and Viewer/Lay Egg 

This function creates an executable file containing the 3D volume data from the scan that is currently open as well as a 2D 
Invivo viewer program. This function is designed to allow the sharing of scan data from an Invivo user to a non-Invivo 
user on shareable media such as a CD, DVD, or flash drive. Note that some antivirus programs may detect the file as a 
virus due to its executable format. 

EggViewer: Running this file initializes 
the viewer program and then loads the 
embedded scan data. The EggViewer 
contains some Section, ArchSection, and 
Gallery functionality.  

                

Export to CD 

This function exports the currently opened scan as a compressed or uncompressed DICOM or a full, compressed, or 
customized setting Invivo file. The exported file is placed in the temporary burn location in the computer.  
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Send File 
Invivo Workspace 
The active case can be sent through Invivo Workspace as 
an Invivo, single file DICOM, multi-file DICOM with 
DICOMDIR, or multi-file DICOM with .dcm extension 
file types. The software prompts the user to sign in to an 
Osteoid Cloud account if not already logged in. 

 

After logging in, the user can input the recipient’s name, 
email, message subject, and discussion notes. Existing 
contacts in Invivo Workspace can be searched to 
automatically populate the contact. The case and message are 
sent to the recipient’s Invivo Workspace account. The 
recipient can then preview the case through the browser 
viewer or download it for further use.  
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Upload for Service 

To send the case directly to the Invivo Service website for the 
Invivo Model service, input the Invivo Service login when 
prompted. Toggle on “Remember Me” to retain the login 
information and click Upload to upload the case. If further 
instructions are required for processing the case, please contact the 
Invivo Model department at 408-333-3484 ext. 5.  
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Case Information Display 

To display or hide the Case Information for a specific patient, go to the “File” → “Case Info.” Click Anonymize then click 
OK to save the changes. 

   

Manage Workflow 

To edit the naming, order, and number of tabs that load with the software, go to the “File” → “Manage Workflow.” 

To rename a tab, click on it in the Name column in the My Workflow window, and type directly into the field. To change 
the order of tabs, click on the tab and select “Move Up” or “Move Down.”  

To add or remove tabs, select them from the Source Views window or the My Workflow window and select the button to 
add or remove respectively. 

The software must be relaunched to apply the workflow changes. 

Image Capture to File 

To capture an image of the active display to file, click “View” → “Capture to File.” Browse to the location to save the 
image, type the name of the file, choose the file type on the “Save as type” drop-down, and click Save. The file can be 
saved as bmp, jpg, or png format. Jpg is the most popular file format for images, but there is a small amount of color 
degradation. Bmp preserves the image, but the file size is big. Png is an effective lossless format that does not degrade the 
color. 
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Image Capture to Gallery 

Selecting “Capture To Gallery” or pressing Ctrl + G captures an image of the rendering window and saves it to the Image 
List (see Gallery Tab features for additional information, pg. 113). 

 

Image Capture to Clipboard 

Selecting “Capture To Clipboard” captures an image of the rendering window to the clipboard for pasting in other programs 
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Image Capture to File in Temporary Folder 

Selecting “Capture To File In Temporary Folder” captures an image of the rendering window to the temporary folder set 
in File → Preferences. The image is always named “Untitled.jpg”. 
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Software Update 

Checking availability of any software updates can be done through the help menu. By default, a check will be performed 
when the application is launched. 

• Selecting “Check for Updates” will check to see if any updates are available for Invivo. If an update is available, 
the option to download will be provided. Select a location to save the installer. The download will happen in the 
background and when complete, a notification will appear. 

 

• Selecting “Disable Automatic Update” will provide the options to postpone or completely disable any checks for 
updates. 

 

 

• Selecting “Enable Automatic Update” will re-enable the check for software updates at launch. 

 

 

Instructions for Use 

Selecting “Instructions for Use” will open the instruction manual that is installed along with the software. The latest version 
of the instruction manual can be found at the Osteoid knowledge base (learn.osteoidinc.com). 
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Image Navigation 
Below is an explanation showing how to manipulate images in the rendering window with the keyboard 
and mouse. 

Zoom In/Out  

• Place the mouse cursor in the center of the image. 
• Hold down the “Control” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse up 

and down on the screen. 
• This shrinks/enlarges the image: Down vertically zooms out. Up 

vertically zooms in. 
• Additionally, in the Section and Volume Render tabs, you can zoom by 

holding the right mouse button. 

 

Pan (Shift) 

• Place the mouse cursor in the center of the image. 
• Hold down the “Shift” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse any 

direction to achieve the desired image displacement. 
• Additionally, in the Section and Volume Render tabs, you can pan by 

holding both the left and right mouse buttons. 
 

 

Free Rotate 

Applicable only for 3D images.  
 
• Place the mouse cursor in the center of the image.  
• Hold down the left-button on the mouse. 
• While holding down the left-button, move the mouse in any direction to 

achieve the desired rotational position. 
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Free Rolling 

Applicable only for 3D images.     
 

• Hold down the “Space” key + left-button on the mouse. 
• While holding down the buttons indicated above, move the mouse up and 

down to rotate the image about a central axis. 
 

 

Increment Rotate 

Applicable only for 3D images.     
 
• Use the keyboard arrows to rotate the 3D Model 1 degree up, down, right, or left, perpendicular to the computer 

screen. 
 

Increment Roll 

Applicable only for 3D images.     
 
• Hold down the “Control” key and use the left and right keyboard arrows to rotate the 3D Model 1 degree rolling 

left or right about a central axis. Pressing left and right keyboard arrows without the Control key pressed rolls the 
image left or right. Use the up and down keyboard keys to roll the image up or down.  

 
Anatomical Plane Clipping 

Applicable only for 3D images.  
 
• Enable clipping in the Control Panel. 
• Place the mouse cursor over the center of the image, then scroll the mouse 

wheel forward or backward to clip the anatomic plane as desired. 
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Scroll Slice 

• For 2D views, place the mouse cursor in the center of the image then scroll the 
mouse wheel forward or backward to move one slice at a time. 

 

 
Move/Rotation Widget 

• Superimposition View: Click on either the ring or the arrows circling the patient 
and move it in the direction to orient the patient.  

• Model View: Use to move a model through a portion of the volume for simulation 
creation. Click on either the ring or the arrows circling the model and move/rotate 
it in the direction to move the model. 

 

 

 

 

Full Screen Mode 
Below is an explanation pertaining to running the software in full screen mode. 

Switching to Full Screen Mode 

From the software menu, select “View” → “Full Screen.” “Full screen stereo” is only applicable for the stereo display 
system. To return to the normal screen mode, press the “Esc” key on the keyboard.  

 

  



 
 
 

     43 of 203                                 

OSTEOID®
 – DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

UM-VET-ENG-72A ANA003 Rev A  NOV 11th, 2025 PAGE 

3D Section View Features 
The 3D Section Tab (also known as the Volume Render Tab) shows the patient in three-dimensionally 
reconstructed views and allows for the exploration of internal structures and never-before-seen views of 
the patient. 
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3D Section / Volume Render: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Volume Render View Tab: 

 
 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 
Quick Zoom: Click the zoom icon, then the point on the volume to zoom in. Use Reset View icon to go 
back to normal size. 

 
Slice Explorer: Once activated, clicking on a point on the volume opens a 2D zoom window in that 
location. The zoom window can be scrolled through using the mouse wheel. 

 
Freehand Sculpture: Freely outline an area and remove the volume perpendicular to the plane of the 
screen. The volume inside or outside the selection can be chosen by clicking in the respective areas.  

 

Polygon Sculpture: Outline an area by placing a series of points and right-clicking. The volume 
perpendicular to the plane of the screen is removed. The volume inside or outside the selection can be 
chosen by clicking in the respective areas. 

 

Marker: Select this option to mark a point on the volume and X, Y, Z coordinates (axial, sagittal, vertical) 
appear. Clicking on the point and moving the cursor can modify points. Click on the point and press the 
“delete” key to delete it. Control Panel features allow the values to be hidden or exported to a report. 

 

Distance Measurement: Select this option and mark two points on the volume, and the distance appears. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press the 
“delete” key to delete it. Control Panel features allow the values to be projected to 2D, hidden, or exported 
to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between them 
appears. Clicking on their control points and moving the cursor can modify measurements. Click on the 
measurement and press the “delete” key to delete it. Control Panel features allow the values to be projected 
to 2D, hidden, or exported to a report. 

 

Polyline Measurement: Select this option and mark any number of points on the volume. Right-click to 
end the measurement, and the total distance appears.  Clicking on the nodes and moving the cursor can 
modify points. Click on the measurement and press the “delete” key to delete it. Control Panel features 
allow the values to be projected to 2D, hidden, or exported to a report.  

 
Volume Measurement: This button opens the volumetric measurement window. 
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Quick Measurement: Click to activate a ruler at the tip of the cursor. Click again to turn off. 

 
Reorientation: Change the patient orientation. See page Error! Bookmark not defined.. 

 
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label and press 
OK. 

 
Grid: Toggles between four different grid layouts for simple assessment of size, measurement, and spatial 
location. 

 
Information Display: Displays or hides case information embedded in the scan data. 

 
View Sequence: Allows for the creation of custom camera sequences and AVI file movie capturing. Refer 
to the View Sequence description (pg. Error! Bookmark not defined.). 

 
Settings: Allows option to view either parallel or perspective views in 3D. 

 
 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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3D Section / Volume Render: Control Panel 

 

Rendering: 
Different methods of rendering can be selected as needed. 
• Method: “Performance” is fast but there are some rendering 

artifacts. “Quality” gives the highest level of detail, but 
response is slower. “Default” is in between the other two 
options.  

• Reconstruction: There are three possible reconstruction 
methods: Volume Rendering, Maximum Intensity, and X-ray.  

View Control: 
• Color Presets: Gray Scale, Inverse, Soft Tissue 1, etc. allows 

better visualization of certain anatomic structures, soft tissue 
profiles, airway, etc. The color rendering is only for 
visualization. The colors are based on densities but DO NOT 
represent the density value of the bone.  

• Opacity: Allows for the translucency/opacity to be adjusted. 
• Brightness & Contrast: Can be adjusted for each of the presets 

to enhance the image.  
Clipping: 
• Click the “Enable Clipping” box to slice the image along the 

predefined anatomical planes (sagittal, axial, coronal, and 
arch). 

• Scrolling the mouse wheel or slider moves the clipping plane. 
• To switch a view to the opposite side, click “Flip.” 
• Custom: This option places the clipping plane at a custom 

position and orientation. 
• Modify Custom Plane: Allows the user to modify the 

position and orientation of the clipping plane. 
Measurement: 
• Measurements can be projected as 2D values or hidden by 

clicking the appropriate box. 
 

• Delete All deletes all measurements within the rendering window. 
• Report exports the values and annotations to a .CSV file for viewing and/or performing computations as 

a spreadsheet. 
Annotation: 
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off by selecting “Visible.” 
• Layout: Sorts all added comments in the rendering window based on selected setting (Horizontal, Stick to 

Point, User Dragged, Vertical, Vertical Even Distributed, Vertical Round Distributed). 

Visibility: 
• Nerves, Stone Models, Implants, etc. visibility can be toggled on and off. 
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3D Section / Volume Render : Rendering Window 

One of the most powerful features of Invivo is the remarkable rendering quality and speed at which the software works. 
The simplicity of this window is that it only displays the volume, patient information (if desired), and the opacity, 
brightness and contrast values. 

 

 
Please refer to Image Navigation (pg. 39) for information about controlling and adjusting these 
images. 
 
 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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3D Section / Volume Render  – Set Custom / Custom Transfer Function Editor 

The Set Custom button provides the user the ability to create a custom preset view. Once the preset is customized within 
the Volume Render tab, it can be utilized in the other tabs such as Implant, Model, and 3D Analysis. 

After selecting the “Set Custom” button in the Control Panel, the Custom Transfer Function Editor will appear. 

 

• Color Gradient Editor 

o This section allows you to modify the color gradient that is applied to a selected trapezoid. In this 
section users can add color triangles to refine the color gradient by selecting the Add Triangle button. 
By selecting the Delete Triangle button the user can remove color triangles which allows them to 
decrease the steps in the color gradient. 
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o Selecting the color triangles and shifting them left or right allows the user to adjust the color range that 
is visible in the trapezoid. 

 

o Double clicking on the Color Triangle displays the Color pallet which allows the user to change the 
individual colors in the Color Gradient. 

 

• Visibility Editor 

o This section controls the visibility/transparency applied to the trapezoid. The size and placement of the 
trapezoid controls the visibility for the covered scalar range. 

 

o The Opacity Histogram contains the trapezoid(s) and provides a graph displaying the relative quantity 
of data for a given scalar value. (The higher the graph value, the more data of that particular scalar 
value is present in the study). 
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o The Density Histogram shows the density distribution of the study. The least dense starting on the left, 
to most dense towards the right. 

 

o The Scalar Values axis provide the range of scalar values present to the study, and correspond with the 
graphs above it. 

 

• Custom Presets Manager 

o Users can save profiles of the custom presets they create, allowing them to quickly access previously 
created presets, as well as share or import them. These presets are saved locally on the user’s machine 
here: C:\Users\[user]\Documents\Anatomage_Cases\View Control Presets. Sharing both the VCF 
and VCG files allows other users to import them. 

 Save As: Save the current preset. Users can access previously saved or imported presets 
through the drop-down menu.  

 Import: Navigate to the set of VCF/VCG files to import them into the preset folder for use. 

 Delete: Deletes the current profile from the menu, as well as removes the files from the preset 
folder. 

• How to create a Custom View 

o Users can select a preset view and modify it as they wish to make a Custom View. Or they can delete all 
trapezoids in a preset view then select the Add Trapezoid button and create a completely new Custom 
View. 

o Clicking on the bar or point of the trapezoid and shifting it to the top or bottom of the Opacity 
Histogram will change the transparency of the Volume rendering. 
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o Clicking on the bar or point and shifting it to the right or left of the Opacity Histogram will allow the 
user to display more or less of the data in the study. 

 

o Once the user is satisfied with their Custom View, they must select the “Set Custom” button to save it 
as a custom preset. They can also save the profile by clicking “Save As” first, then clicking the “Set 
Custom” button to set the profile. 

 

o The user can then select the “Custom” button it the view control in the control panel to use their new 
custom view. 
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3D Section / Volume Render : Reorientation 

The reorientation tool provides the user a way to orient the volume using references lines as well as to reset the image 
to the default coordinate system. 

• After selecting the reorientation icon in the toolbar, left-click and drag each reference line to the approximate 
proper location on the volume (ex. Frankfort Horizontal in sagittal view).  

• If the patient orientation had previously been adjusted, the tool provides the options to reset to the default 
orientation of the scan or to adjust the current orientation. 

• Left-click and drag the rotation handles to rotate the volume to match the reference line. 

• Rotate the volume to visualize the rotation widgets on the other axes. 
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3D Section / Volume Render: Volume Measurements 

 

The Volume Measurement tool can be used to estimate displaced volume (cc or cubic millimeters) of a specific 
anatomical structure. The desired anatomical structure must first be isolated by sculpting.  

Then, press the Volume Measurement  button. A new window opens, and the volumetric measurement value 
is displayed. Finally, the threshold values can be adjusted to obtain desired measurements. The volume measurement 
function is linked to rendering; the Inverse rendering preset can be used to take volumetric measurements of air. 
 
 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of the 
imaging, there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off scale H.U. The 
software measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the 
measurement values depend on threshold values; thus, user must set proper thresholds to get the best estimate of the 
desired structure. The measurements must not be used as the sole metric for any treatment. 

 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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3D Section / Volume Render : Movie Capturing and Customized View Sequences 

 

 

 View Sequence: 
• Create sequences by clicking on Insert for each step the 

volume transitions through.  
o For a movie that spins the volume left to 

right, and then turns up for a submental 
view, a frame should be inserted for each 
major view, and the View Sequencer 
connects the positions in a seamless movie. 

• Multiple, different rendering presets can be integrated 
so that the sequence changes not only in position but 
also in colorizations. 

• Video sequences can be saved for future use and then 
loaded using the Load and Save As buttons under 
Sequence File. 

• Click on VIDEO Capture to open a dialog to 
customize and save the movie file. 

 

Movie Capture: 
The VIDEO Capture button allows for customization, 
capturing, and exporting of an AVI (movie) file of the volume 
rendering sequence. 
 
• Select Change to determine the AVI file name and save 

location. 
• Set the frames/view and frames/sec to desired values. 

o More frames/view make the video 
smoother. 

o More frames/sec make the video run faster. 
• Add an ending logo by selecting Browse and choosing 

an image file to display at the end of the video. 
o Select “Add Logo” to add the ending 

image. 
o Set the duration and background color. 

• Click Capture once everything is set up to 
automatically export the video to the specified location 
with the specified name. 
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2D Section View Features 
The 2D Section View Tab (also known as the Section View tab) gives the ability to view the X, Y, and Z 
sections (axial, coronal, sagittal) and user-created, custom sections simultaneously for 2D visualization, 
measurements, and the utilization of several image enhancement features. Invivo also integrates 3D 
functions in the Section View Tab. 
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2D Section: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Section View Tab: 

 

 Reset: Resets the rendering window to the original view size and the brightness and contrast to the preset. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A number 
in millimeters automatically displays. Click on the measurement and press the “delete” key to delete it. 

 

Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click the last 
point to create an angle. A number in degrees automatically displays. Click on the measurement and press 
the “delete” key to delete it. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of the desired area. 
Double-click or right-click to end the measurement. A number in millimeters squared automatically 
displays. Click on the measurement and press the “delete” key to delete it. 

 

Polyline Measurement: Select this option and mark any number of points in the slice view. Right-click to 
end the measurement, and the total distance appears.  Clicking on the nodes and moving the cursor can 
modify points. Click on the measurement and press the “delete” key to delete it. 

 
Reorientation: Click this button to re-orient the image. Grab the arrow widgets and rotate the image to the 
desired orientation. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 

H.U. Measurement: Calculates the HU value of an area within a bounding rectangle, circle, or ellipse. 
The measurements display alongside the shape and can also be repositioned by dragging. The information 
updates when the box is moved or if the user scrolls. 

 
Layout: After clicking on the layout icon, a list of various layout options appear. Click on the desired layout 
to apply it. 

 
Toggle Cursor Visibility: Cycles through available cursor styles and turns cursor on and off. 

 
Information Display: Displays or hides case information embedded in the data. 
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View Sequence: Allows for the creation of custom camera sequences and AVI file movie capturing. 
Refer to the Volume Render View Sequence section (pg. Error! Bookmark not defined.) for 
additional information and description. 

 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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2D Section: Control Panel 

 

Layout: 
• Default: Reset to the original layout. 
• Change Layout: Click to choose custom layout. 
View Control: 
• Brightness & Contrast: Can be adjusted for each of the presets 

to enhance the image. Clicking and dragging the mouse 
up/down on the 2D views increases/decreasse the brightness. 
Clicking and dragging the mouse right/left on the 2D views 
increases/decreases the contrast. 

• Rendering Preset (drop-down list): The presets either load a 
brightness/contrast setting that is optimized for a particular 
tissue type or a color preset. 
• Dental (custom), Abdomen, Bone, Brain CT, Liver, Lung, 

Mediastinum, and Grayscale options are available. 
• Color Presets: Allows better visualization of certain 

anatomic structures, soft tissue profiles, airway, etc. The 
color rendering is only for visualization. The colors are 
based on densities but DO NOT represent the density 
value of the bone.  

• Sharpening Filter: Applies the selected sharpening filter from 
the drop-down menu to the 2D slice renderers. 

• Slice Thickness: Uses ray sum when reconstructing the 3D 
image along each orthogonal plane. 

• Slice Interval: The user may also define the Slice Interval by 
selecting a drop-down option between 0.1-20.0 mm or by 
manually entering a number within that interval on the 
keyboard. 

Additional View: 
• 3D Volume: This option allows 3D volume rendering in the fourth corner of the window. 
• Custom Section: This option allows for the creation of a custom section. 
• Airway: This option displays the airway in the 2D slices and as a 3D model if present in the case.  
Custom Section:  
• Click Create to start a custom section. By clicking two points, a customized section can be created on any 

cross section to better visualize anatomy along that axis. The custom section can be navigated by clicking 
and dragging the arrows to rotate, the endpoints to lengthen, or the center point to drag the entire section 
freely. 

• Delete: Removes the custom cross section made in the rendering window. 
• Slice Thickness: Adjusts the slice thickness of the custom section. Slice thickness can also be adjusted 

using the circular handles flanking the center of the section. 
3D Volume Clipping: 
• When 3D volume is enabled, this option clips the volume for viewing the internal anatomy. The clipping 

plane is synchronized with section cursors. 
• Custom: This option places the clipping plane at a custom position and orientation. 

• Modify Custom Plane: Allows the user to modify the position and orientation of  the clipping 
plane. 
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Image Info: 
• Dimension, resolution, and field of view size are summarized. 
Pointer Coordinates: 
• IJK or XYZ: coordinates give the user the ability to examine the coordinate of the cursor upon the absolute 

coordinate system. 
• Scalar Value is the gray scale value of the voxel pointed by the cursor pointer. H.U. or Hounsfield unit, is 

an approximate value of the voxel calculated by “Rescale Slope” and “Rescale Intercept” in DICOM 
information. H.U. value approximations may not be as accurate if the CT hardware calibration is off. 
Contact the hardware manufacturer for more information about H.U. accuracy. 

Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 

section in Preferences (pg. 21) for more information on which settings are saved for this specific tab.  
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2D Section: Rendering Window 

This window allows viewing of the X, Y, and Z sections (axial, coronal, sagittal) and custom sections or a 3D view 
simultaneously. This allows the clinician to have very accurate 2D visualization and 2D measurements. 

 

 
 
Scroll wheel: Move mouse pointer to the desired cross section. Use the scroll wheel to move the slice up and down. 
 
Cursor: Grab one of the cursors (axial, sagittal or coronal). Move the cursor in the desired direction. The 
corresponding image is updated. 
 
Center Circle: Pick a point inside the center circle. Move the circle in the desired direction. The other two images 
are updated. 
 
Zoom: Click and hold the left-click mouse button on the image and the “Ctrl” key on the keyboard. Alternatively, 
hold down the right mouse button. Drag the mouse cursor up and down to zoom in and out. 
 
Pan: Click and hold the left-click mouse button on the image and the “Shift” key on the keyboard. Alternatively, 
hold down both the left and right mouse button. Drag the mouse cursor to move the image. 
 
Brightness: Click on a slice in the axial, sagittal, and coronal views and drag the mouse to adjust the brightness 
and contrast. Dragging the mouse up/down increases/decreases the brightness. 
 
Contrast: Click on a slice in the axial, sagittal, and coronal views and drag the mouse to adjust the brightness and 
contrast. Dragging the mouse left/right increases/decreases the contrast. 
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2D Section: Reorientation 

The reorientation tool provides the user a way to orient the volume using references lines as well as to reset the image 
to the default coordinate system. 

• After selecting the reorientation icon in the toolbar, choose between rotation modes.  

 

o Rotate Volume: Dragging the rotation handles rotates the volume, while the axes remain static. 

o Rotate Axes: Dragging the rotation handles rotates the axes, while the volume remains static. 

 

• If the patient orientation had previously been adjusted, the tool provides the options to reset to the default 
orientation of the scan or to adjust the current orientation. 

• Left-click and drag each reference line to the approximate proper location on the volume (ex. Frankfort 
Horizontal in sagittal view).  

• Left-click and drag the rotation handles to rotate the volume/axes to match the reference line. 

• Rotate the volume/axes to visualize the rotation widgets on the other axes. 
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• The reorientation dialog displays the degrees of rotation. Additionally, rotation can be performed by typing in 
numerical values or using the arrows to step through values. 

 

Warning: Values entered in the dialog are relative to the orientation at the moment and are not a display of a cumulative 
transformation matrix. The order in which you enter values affects the orientation. For example, entering a change of 90 degrees in 
the sagittal box first, then 90 degrees in the coronal box next, will result in a different orientation than if the order was reversed. 
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2D Section: Light Box 

 

Change Layout has the option to change the 
Section view format to a “Light Box” style.  

• The Light Box is composed of 4-32 
sections of either axial, sagittal, or 
coronal views.  
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3D Pano View Features 
The 3D Pano View Tab (also known as the Super Ceph tab) gives the ability to construct and view an 
enhanced version of a cephalometric radiograph, take measurements, and utilize several image 
enhancement features, all of which dramatically increases its diagnostic value. 
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3D Pano / Super Ceph: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Super Ceph View Tab: 

 

 
Reset: Resets the rendering window to the original view. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A number 
in millimeters automatically displays. 

 
Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click the last 
point to create an angle. A number in degrees automatically displays. 

 
Text Notation: Allows text to be written and edited on the image. 

 
Grid: Toggles between two different grid layouts for use in all of the section frames allowing quick 
assessment of measurements and spatial location. 

 
Information Display: Displays or hides case information embedded in the data. 

 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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3D Pano / Super Ceph: Control Panel 

 

Create Ceph 
• The Create Ceph button should only be clicked after the 

orientation of the patient’s volumetric image is adjusted in the 
rendering window. 
The “Set Orientation” box resets the orientation if a ceph was 
created incorrectly. Once the image is orientated correctly, press 
the Create Ceph button again. 

Layout: 
“Screen” layout is optimized for viewing the image on the computer 
screen. “Print Out” layout is optimized for printing the image on paper. 
With Print Out layout, the exact screen display is printed on the paper in 
life-size. First, capture to Gallery, then print from Gallery to ensure the 
image is life size. 
Traditional Gray Scale Ceph 
• Brightness and Contrast can be adjusted to enhance the image. 
• The “Enhanced” box can be left-clicked on or off to sharpen 

and enhance the quality of the image. 
• Range Setup sets the side of the patient’s head the ceph is 

created from. Thickness controls the width of the range. 
• When the Range Setup is changed, the ceph image must be 

recreated using the Create Ceph button. 
• Sharpening Filter: Applies the selected sharpening filter from 

the drop-down menu to the 2D slice renderers. 

Volume Ceph 
• Increase the Opacity slider to superimpose the volume rendering onto the generated ceph. 
• Various enhanced views of the ceph can be added that allows better visualization of certain anatomic structures, 

soft tissue profiles, airway, etc.; each has different advantages. 
• The color rendering is only for visualization. The colors are based on densities but DO NOT represent the density 

value of the bone.  
• Bone highlights hard-tissue landmarks. 
• Soft+Bone emphasizes the soft-tissue on the ceph 
• Opacity, brightness, and contrast can all be adjusted for image enhancement. 
• Inverse switches the background to white. (Gray Scale coloring switches black/white.) 
• Range Setup sets the side of the patient’s volume that is superimposed. 
• Projection provides options to switch between parallel views of the cephalometric images and perspective views 

which resemble the magnification found in traditional cephalometric radiographs. 
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3D Pano / Super Ceph : Rendering Window 

This window is where the volumetric image of the patient is orientated to create a ceph and where the ceph is viewed after 
creating it. 
 
Before clicking on the Create Ceph button in the Control Panel, the patient’s volumetric image must be correctly 
orientated. The easiest way to do this is to line up the left and right angles of the mandible. If the ceph is created with an 
improper orientation, it can be adjusted using the “Set Orientation” box in the Control Panel. 
 

 
 
Please refer to Image Navigation (pg. 39) for information about controlling and adjusting these 
images. 
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2D Pano View Features 
The 2D Pano View Tab (also known as the Super Pano tab) can construct and display an enhanced version 
of a panoramic radiograph, take measurements, and utilize several image enhancement features. It also 
has the ability to render a pano into a volumetric 3D image that can be rotated for greater visual 
advantages. 
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2D Pano / Super Pano: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Super Pano View Tab: 

 

 
Reset: Resets the rendering window to the original view. 

 

 

Create Focal Trough: Sets the boundaries of the Super Pano. A focal trough is automatically set but can be 
adjusted or recreated entirely. Use the yellow dots to stretch, widen, or reshape the focal trough. The focal 
trough selects only the desired anatomy and excludes others such as the spine, which traditionally appears 
in panoramic radiographs as background noise. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A number 
in millimeters automatically displays. 

 
Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click the last 
point to create an angle. A number in degrees automatically displays. 

 
Grid: Toggles between three different grid layouts for use in all of the section frames allowing quick 
assessment of measurements and spatial location. 

 
Information Display: Displays or hides case information embedded in the data. 

 
Comment Marker: Pick a point in the panoramic and enter comments. 

 

  

 

 

  

 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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2D Pano / Super Pano : Control Panel 

 

Create Pano 
• The upper-lower limit is adjusted by left-clicking on a green line and 

dragging with the mouse. It specifies the vertical dimension of the 
pano that is being created. 

• The focal trough is adjusted by left-clicking on the yellow points and 
dragging with the mouse. The length, width, and shape of the focal 
trough are adjusted to specify what appears in the pano. 

• A preview is also shown in the rendering window. 
• The Create Pano button should be pressed after the upper-lower limit 

and focal trough are first adjusted. 
Gray Scale Threshold 
• This threshold sets the density limit in the pano. 
• For noisy images, adjust the threshold so that the noise does not 

contribute to the pano. 
• Threshold is usually set slightly below bone density. 
View Controls 
• Pano can be rendered in multiple visualizations which allows better 

visualization of certain anatomic structures, soft tissue profiles, 
airway, etc. The color rendering is only for visualization. The colors 
are based on densities but DO NOT represent the density value of the 
bone.  

• Enhanced Gray sharpens Gray Scale rendering. 
• By default, Enhanced Gray is selected. 
• Brightness & Contrast: Can be adjusted to enhance the image. 
• Inverse: Switches the background to white (switches coloring for 

Gray Scale Rendering). 
• Sharpening Filter: Applies the selected sharpening filter from the 

drop-down menu to the 2D slice renderers. 
 

3D Settings 
• Enable 3D: Select this feature to render the pano as a volumetric 3D image. The pano can be rotated, clipped, etc. like 

other volumes. (See Image Navigation, pg. 39.) 
• Quality: Select this to give the highest level of detail for the generated pano. 
• A traced nerve or placed implant can be toggled on/off with the “Nerve” and “Implant” boxes. 
Clipping 

This option is only applicable when 3D Pano is available. Clipping hides some part of the image so that the internal structure 
can be visible. 

Axial Setup 
The slice mode box sets how the focal trough is shown. 
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2D Pano / Super Pano : Rendering Window 

Upper-Lower Limit: The lower left box where the vertical parameter of the Super Pano is set. The green lines indicate the vertical 
limits. They can be dragged to set the desired upper and lower limit of the Super Pano. When “Slice Mode” is selected, the red line 
indicates where the focal trough plane is and can also be adjusted. 

Focal Trough: The focal trough is adjusted in the lower middle box. Whatever is contained within it appears in the Super Pano 
allowing the construction of a panoramic x-ray with minimal background noise. The yellow dots can be left-clicked and dragged 
to adjust the length, width and shape of the focal trough. The focal trough can be adjusted by dragging the focal trough control 
points, or a new trough can be created by clicking the trough icon on the toolbar. 

Preview: A preview of the Super Pano is displayed in the lower right box before creating it. This feature allows a Super Pano to be 
efficiently made with fewer or no adjustments needed afterward. 
 

 
 
How to make a good Pano?  
• Make a U-shaped, narrow focal trough encompassing the arches by adjusting points on the focal trough. 
• Adjust Gray Scale threshold to filter soft tissue, so that the image is not too dark or too light. 
• Refer to Image Navigation (pg. 39) for information about controlling and adjusting these images. 
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ArchSection View Features 
ArchSection View Tab is a sectional image exploration view. Instead of conventional X-Y-Z sections, this view 
allows the user to review the image in dentally meaningful perspectives using multiple cross sections, traversing 
the lengths of the dental arches. 
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ArchSection: Toolbar 

Shown below are the Toolbar and tools that are loaded with the ArchSection Tab: 

  

 
Reset: Resets the window to the original view. 

 

Create Arch Spline: After selecting this tool, create a new arch spline or edit an existing arch spline. Left-click to 
place nodes along the arch. Right-click or double-click to finish the arch spline. To modify an existing arch spline, 
drag the nodes to the desired positions. To move the arch while maintaining its shape, click and drag the central 
spline.  

 
Arch Spline Ruler: Places ruler along the arch spline for easy reference. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A number in 
millimeters automatically displays. 

 

Angle Measurement: Select this option and mark three points on the volume, and the angle between them appears. 
Clicking on their control points and moving the cursor can modify measurements. Click on the measurement and 
press the “delete” key to delete it. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of the desired area. Double-
click or right-click to end the measurement. A number in millimeters squared  automatically displays. Click on the 
measurement and press the “delete” key to delete it. 

 

Polyline Measurement: Select this option and mark any number of points in the slice view. Right-click to end the 
measurement, and the total distance appears.  Clicking on the nodes and moving the cursor can modify points. 
Click on the measurement and press the “delete” key to delete it. 

 
Reorientation: Adjusts the patient orientation and the visible range of the scan. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 

H.U. Measurement: Calculates the HU value of an area within a bounding rectangle, circle, or ellipse. The 
measurements display alongside the shape and can also be repositioned by dragging. The information updates when 
the box is moved or if the user scrolls. 

 

Slice Capture Mode: Opens the Slice Capture Manager to enable the capture of slices or groups of slices 
from a series of cross sections. Requires the creation of a slice group in the Report Tab and an activated 
Report module. 

 
Rotate Cross Section: Adjusts the patient orientation in the cross sections. 

 

Layout: After clicking on the layout icon, a list of various layout options appear. Click on the desired 
layout to apply it. A custom layout can be created and loaded. 

 
Toggle Cursor Visibility: Conceals or displays cursors. 

 
Information Display: Displays or hides case information embedded in the data. 

 

View Sequence: Allows for the creation of custom camera sequences and AVI file movie capturing. Refer 
to the Volume Render View Sequence (pg. Error! Bookmark not defined.) section for additional 
information and description. 
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Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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ArchSection: Control Panel 

 

Layout: 
• Change Layout adjusts the layout with different numbers of slices 

and orientations. A custom layout can be configured. (See page 80.) 
• Maxillary Arch and Mandibular Arch options allow two different arch 

splines to be created and saved. Switching between the two options 
changes which spline is manipulated and used in creating the 
panoramic and cross sections. 

• “Print Out” layout is optimized for printing the image on paper. With 
Print Out layout, the current view can be printed on the paper in life-
size. First, capture to Gallery, then print from Gallery to ensure the 
image is life size. 

Axial Section: 
• Interval: Distance between the subsequent axial sections. 
Cross Section: 
• Width: Cross-section width. 
• Interval: Distance between the subsequent cross sections. 
• Thickness: Allows for the cumulative thickness of the slices to be 

viewed in the cross sections. 
• Auto R-L: This allows the cross section to be oriented to a consistent 

R-L orientation on the screen. If turned off, the cross-section 
orientation is consistent to the arch spline. 

Panoramic Image: 
• Slice mode displays a single cross section along the panoramic curve (yellow). This mode is used for tracing the 

nerve. 
• X-ray shows the ray sum (reconstructed x-ray) in the focal trough. 
• Ruler: Displays a ruler on the bottom of the panoramic image. 
• Tru-Pan™: This option enables the one-click volumetric pan that can be created from scans taken by an i-CAT© Cone 

Beam 3D system. (This setting is only displayed in the Control Panel when a Tru-Pan™ case is currently loaded.)  

View Control: 
• Brightness and Contrast can be used to adjust the image. 
• The All drop-down allows for brightness/contrast adjustments in different areas independently. 
• Different Color Presets can be used to view the images in color. 
• Sharpening Filter applies the selected sharpening filter from the drop-down menu to the 2D slice renderers. 
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Nerve Pathway: 
• New Nerve: Starts a new nerve tracing. 
• Modify: Allows editing of the selected nerve tracing. 
• Visibility: Controls the visibility of the nerve in the section and X-ray renderers. 
• Nerve Node: Select a specific node for modification. 
• Diameter: Selects the diameter of the nerve that has been traced or a specifically selected node. 
• Delete: Deletes the last placed node during the tracing or the entire nerve if Modify is active. 

 
 Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences section in 

Preferences (pg. 21) for more information on which settings are saved for this specific tab.  
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ArchSection: Rendering Window 

 
 
Arch Cursor: Notice the green, orange, and brown coordinate indicators. These ArchSection coordinate indicators show the 
spatial location within the ArchSection modeling window. 
• Cross Section Indicator: The green lines give the location of the cross sections along the arch spline.  
• Axial Slice Indicator: The orange line shows the axial coordinate position within the section.  
• Arch Spline: The brown spline in the center of the arch spline represents the current position where the arch section has moved. 
• Cross Section: Mouse scrolling within any one of the three sagittal frames advances the slices to the patient’s right or left and 

causes the green coordinate indicator to move anteriorly or posteriorly in the axial and pano sections simultaneously. The up 
and down keys can also be used to scroll through cross sections by page. 

• Axial Section: Mouse scrolling within the axial section advances the sections superiorly or inferiorly and causes the red 
coordinate indicator to move superiorly or inferiorly in the cross or pano sections simultaneously. 

• Pano Section: Mouse scrolling within the coronal frame advances the slices buccally or lingually and causes the brown 
coordinate indicator to move buccally or lingually in the axial and cross sections simultaneously.                               
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ArchSection: Creating A Nerve Pathway 

Creating a Nerve Pathway (e.g. Inferior Alveolar by following the mandibular canal to its exit). 
• Click New Nerve. 
• Left-click the mouse to start the nerve. 
• Move the mouse to the next point along the nerve path and left-click again. 
• Click Delete to remove the last-placed node if it is mispositioned. 
• Repeat this procedure for the entire length of the nerve. 
• 2.0 mm is the default diameter of the nerve pathway, but the parameter can be adjusted as desired. 
• Press Done to finish. 

 
Editing a Nerve Pathway 
• Click on a nerve tracing to select it. This highlights the nerve in a brighter red color. 
• Click Modify. This reveals all of the nerve nodes that are visible in each slice in blue. 
• Nodes can be moved by clicking and dragging it across the scan. 
• Set the Nerve Node drop-down menu to “All” or a specific node.  
• If “All” is selected, the entire nerve tracing’s diameter can be adjusted. 
• If a single node is selected, it is located in the slices, and its diameter and position may be adjusted independently. The nerve 

node diameter is adjusted in the Diameter drop-down menu.  
 
Deleting a Nerve Pathway 
• The Delete button can be used if a point was plotted in the wrong spot by deleting the last point added. 
• Once a nerve has been completed and Done has been clicked, the nerve can be deleted by clicking on it and pressing the “delete” 

key on the keyboard or the Delete button. 
 

 
 
  

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of the nerve can lead to surgical 
complications if diagnosis, treatment plans and/or actual treatment is based off of the incorrect tracing. It is critical for the end 
user to learn how to properly perform nerve tracings correctly. If you notice any inconsistencies or software problems with 
nerve tracing or have further questions or concerns about nerve tracing, please contact Osteoid support at (408) 333-3484 or 
email us at info@Osteoidinc.com 
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ArchSection: Custom Layouts 

A custom layout can be set by going to the Layout tool or Change Layout. Click Set Custom Layout. 

 

Step 1.  

Select whether the axial slice or the panoramic image should be visible. Set the number of columns and rows of cross sections. At 
least one cross section is always visible. 

Step 2.  

Select whether the main rendering window division is horizontal or vertical. 

Step 3.  

Click and drag the grey dividing borders to adjust the boundaries of each view. This affects the resulting size of each view. 

Once OK is clicked, the custom layout is applied. If another layout is chosen subsequently, the custom layout can be reloaded 
by going to the Layout tool or Change Layout and clicking Load Custom Layout. 
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Airway View Features 
The Airway Tab visualizes and assesses the properties of the patient’s airway and nasal cavity and provides 
additional tools for data export and presentations.  
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Airway: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Airway View Tab: 

 
 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view . 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points in the view, and the distance appears. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press the 
“delete” key to delete it. Control Panel features in Volume Render Tab allow the values to be projected to 
2D, hidden, or exported to a report. 

 

Angle Measurement: Select this option and mark three points in the view and the angle between them 
appears. Clicking on their control points and moving the cursor can modify measurements. Click on the 
measurement and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow 
the values to be projected to 2D, hidden, or exported to a report. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of the desired area. 
Double-click or right-click to end the measurement. A number in millimeters squared is automatically 
display. Click on the measurement and press the “delete” key to delete it. 

 

Polyline Measurement: Select this option and mark any number of points in the view. Right-click to end 
the measurement, and the total distance appears.  Clicking on the nodes and moving the cursor can modify 
points. Click on the measurement and press the “delete” key to delete it. Control Panel features in Volume 
Render Tab allow the values to be projected to 2D, hidden, or exported to a report.  

 
Reorientation: Click to change patient orientation.  

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 
Export Airway Data: If an airway has been generated, this exports the airway model, graphs, slice data, 
and summary data to the selected folder. 

 
Airway Measurement: Trace the airway spline and calculate the volume, A-P and R-L distances, cross-
sectional area, and minimum cross-sectional area. (See pg.87.) 
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Nasal Measurement: Trace the nasal cavity spline and calculate the volume, A-P and R-L distances, cross-
sectional area, and minimum cross-sectional area. 

 
Airway Sculpting: Freely outline an area and remove the part of the airway perpendicular to the plane of 
the screen. The airway inside or outside the selection can be chosen by clicking in the respective areas. 

 
Toggle Cursor Visibility: Cycles through available cursor styles and turns cursor on and off. 

 
Information Display: Displays or hides case information embedded in the scan data. 

 

View Sequence: Allows for the creation of custom camera sequences and AVI file movie capturing. Refer 
to the View Sequence description in the Volume Render View section (pg. Error! Bookmark not 
defined.). 

 
 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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Airway: Control Panel 

 

Layout: 
• Slice: Displays the axial and sagittal slices along with the 3D airway 

model and graphs if the selected profile is present. 
• 3D: Displays the sagittal slice and 3D volume rendering along with 

the 3D airway model and graphs if the selected profile is present. 
Profile: 
• Create: Create a spline by clicking to place nodes along the 

direction of the flow of air. Right-click to finish the spline and 
generate the measurement. (See pg.87.) 

• After creation, the profile can be modified by clicking on it and 
editing the spline in the sagittal slice. 

Airway: 
• Color Minimum: The minimum cross-sectional area that has color, 

starting with red. Any areas smaller than that are in black. 
• Color Increment: How quickly color changes with cross-sectional 

area changes. 
• Threshold: The maximum H.U. threshold that the software detects 

as air. The value in the field defines the central threshold of the 
slider.  

View Control:  
• Brightness & Contrast: Can be adjusted for each of the presets to 

enhance the image.  
• Sharpening Filter: Applies the selected sharpening filter from the 

drop-down menu to the 2D slice renderers. 
• Slice Thickness: Uses ray sum when reconstructing the 2D image 

along each orthogonal plane. 
 

3D Volume Clipping: 
• When the 3D layout is applied, this option clips the volume for 

viewing the internal anatomy. The clipping plane can be adjusted 
with the mouse scroll wheel. 

• Custom: This option places the clipping plane at a custom position 
and orientation. 
• Modify Custom Plane: Allows the user to modify the position 

and orientation of the clipping plane. 

Flythrough: 
• Play: Create a flythrough simulation of the airway. 
• Start/End: Jumps to the start or end position of the simulation. 
• VIDEO Capture: Exports the flythrough simulation as a video file. 
• Reverse Playback: Reverses the direction of the flythrough. 
• Perspective: Toggles on perspective projection. 
• Frames/View: Sets the number of frames for each view. 
• See page 88 for more information. 
Pointer Coordinates: 
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• IJK or XYZ: coordinates give the user the ability to examine the coordinate of the cursor upon the absolute 
coordinate system. 

• Scalar Value is the gray scale value of the voxel pointed by the cursor pointer. H.U. or Hounsfield unit, is an 
approximate value of the voxel calculated by “Rescale Slope” and “Rescale Intercept” in DICOM information. 
H.U. value approximations may not be as accurate if the CT hardware calibration is off. Contact the hardware manufacturer for more 
information about H.U. accuracy. 

Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences section 

in Preferences (pg. 21) for more information on which settings are saved for this specific tab.  
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Airway: Rendering Window 

This window displays the axial and sagittal 2D slices along with the 3D volume, model object, and graph data depending on the 
layout selection and if an airway or nasal cavity has been created. 

 

 
 
Slice view: Axial and sagittal slices are available. Airway measurement is created in the sagittal slice. Profiles are displayed 
after measurement creation. Clicking on the airway subsequently displays the edit widget. 
 
3D volume view: The 3D volume can be manipulated as in other tabs. If an airway measurement is present, a 3D volume 
is displayed.  
 
Airway model view: The 3D airway object can be manipulated similarly to the volume rendering. Total volume and 
minimum area values are displayed. 
 
Graphs: Anterior-posterior and right-left measurements and the cross-sectional areas of each slice of the airway are graphed 
relative to position along the airway spline. Click on the an area of the graph to find the corresponding slice in the airway 
and display specific numerical data. 
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Airway: Airway Measurement 

 Airway Measurement: Selecting the icon displays the dialog box below. Click OK to continue. 

 

 

 
Tracing the Profile: 

• Use the scroll-wheel to locate the mid-sagittal plane. 
• Pick points along the airway to define the measurement 

path with the left-click button. 
• Right-click when finished. 

 

Viewing the Volume Measurement: 
• Invivo converts the profile tracing into a volume 

rendering and superimpose it onto the scan data. 
• The minimum cross-sectional area and total volume are 

displayed next to the airway measurement. 
• The color range and threshold can be adjusted in the 

Control panel. 
• The measurement data can be hidden by checking the 

box for “Hide All Values” in the Control Panel. 
• The airway volume and measurement values can be 

deleted by left-clicking once on the volume, then 
pressing “delete” on the keyboard. 

 

Important: The measurement values may not be true anatomical volumetric measurements. Due to the nature of the 
imaging, there are imaging artifacts such as white noise, scattering, beam hardening, ring noise or off scale H.U. The 
software measurement tool cannot distinguish the imaging artifact from the true anatomy. Furthermore, the 
measurement value depends on threshold values; thus, user must set proper thresholds to get the best estimate of the 
desired structure. The measurements must not be used as the sole metric for any treatment. 

 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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Airway: Flythrough 

After the creation of an airway or nasal cavity measurement, a flythrough simulation can be created. Click “Play” in the Flythrough section 
of the Control Panel. A view sequence following the airway spline is automatically generated. The sequence can be played and reversed, 
and the speed and smoothness can be adjusted through the Frames/View parameter. Perpective camera view can be toggled on if desired. 

 

 
 
Once the sequence is adjusted, it can be exported as a video file through the “Capture” button. 
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Endo View Features 
The Endo View Tab allows for careful segmentation and examination of a single tooth through various unique 
3D volume renderings and 2D slice views. Working length measurements can be performed in this view to 
calculate root and endodontic file lengths. 

 

  



 
 

     90 of 203                                 UM-VET-ENG-72A ANA003 Rev A  NOV 11th, 2025 PAGE 

            

Endo: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Endo View Tab: 

 
 

 Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

FreeHand Sculpture: Freely outline an area and remove the volume perpendicular to the plane of the 
screen. The volume inside or outside the selection can be chosen by clicking in the respective areas. This 
tool can only be used after Select Tooth is complete. 

 

Polygon Sculpture: Outline an area by placing a series of points and right-clicking. The volume 
perpendicular to the plane of the screen is removed. The volume inside or outside the selection can be 
chosen by clicking in the respective areas. This tool can only be used after Select Tooth is complete. 

 

Distance Measurement: Select this option and mark two points in the view, and the distance appears. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press the 
“delete” key to delete it.  

 

Angle Measurement: Select this option and mark three points in the view and the angle between them 
appears. Clicking on their control points and moving the cursor can modify measurements. Click on the 
measurement and press the “delete” key to delete it.  

 

Area Measurement: Select this option and mark any number of points along the boundary of the desired 
area. Double-click or right-click to end the measurement. A number in millimeters squared is automatically 
display. Click on the measurement and press the “delete” key to delete it. 

 

Polyline Measurement: Select this option and mark any number of points in the view. Right-click to end 
the measurement, and the total distance appears.  Clicking on the nodes and moving the cursor can modify 
points. Click on the measurement and press the “delete” key to delete it.  

 
Working Length Measurement: Select this option and mark the desired measurement endpoints in the 
view. The working length is generated between the endpoints, and the total distance displayed. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 
Layout: After clicking on the layout icon, a list of various layout options appears. Click on the desired 
layout to apply it. 
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Grid: Toggles between two different grid layouts for simple assessment of size, measurement, and spatial 
location. 

 
Toggle Cursor Visibility: Cycles through available cursor styles and turns cursor on and off. 

 
Information Display: Displays or hides case information embedded in the scan data. 

 

 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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Endo: Control Panel 

 

Volume of Interest: 
• Select Tooth: After clicking this button, click either on the 2D 

slices or 3D volume to create a box. In the 2D slices, click and 
drag the center of the box to move it. Click on the nodes or 
borders to change the size. Click on the arrows to rotate the 
box. After the box is aligned with the desired tooth, right-click 
or click Apply to segment the region within the box into a 
volume of interest (VOI). 

o If a VOI has already been created, clicking Select 
Tooth provides the options to edit the current 
VOI or create a new one. 

• Cancel: Cancels the Select Tooth process. 
• Reset: Resets the current VOI to the original scan. 

Layout: Changes the right section of the rendering window. 
• Volume: Displays the volume rendering of the VOI if one has 

been created or the original scans. 
• Axial: Displays the 2D slices along the z-axis of the VOI. 
• Lateral: Displays the 2D slices around the z-axis of the VOI 
• Endoscopy: Displays a 3D slice along the z-axis of the VOI. 

The rendering type is set in the View Control section. 

View Control: 
• Color Presets: Teeth, Pulp, Bone, etc. allows better 

visualization of certain anatomic structures, soft tissue 
profiles, airway, etc. The color rendering is only for 
visualization. The colors are based on densities but DO NOT 
represent the density value of the bone. Certain options may 
not be available until the creation of a VOI. 

• Threshold: Filters the H.U. values that are visible in the volume rendering 
• Brightness & Contrast: Can be adjusted for each of the presets to enhance the image. 
• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D slice 

renderers. 
• Slice Thickness: Uses ray sum when reconstructing the 2D image along each orthogonal plane. 
• Rendering: “Performance” is fast but there are some rendering artifacts. “Quality” gives the highest level 

of detail, but response is slower. “Default” is in between the other two options.  
Working Length: 
• Measurement: Creates a working length measurement. 
• Clear All: Deletes all working length measurements 
3D Volume Clipping: 
• When 3D volume is enabled, this option clips the volume for viewing the internal anatomy.  
• Custom: This option places the clipping plane at a custom position and orientation. 

• Modify Custom Plane: Allows the user to modify the position and orientation of  the clipping 
plane. 

Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 

section in Preferences (pg. 21) for more information on which settings are saved for this specific tab. 
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Endo: Rendering Window 

A 3D volume view and the axial, sagittal, and coronal slices are displayed by default. Other layouts exchange the 3D 
volume for additional slice or endoscopy views. 
 

 
 
Slice view: Axial and lateral slices are available. Scrolling along the z-axis or laterally can be applied.  
 
3D volume view: The 3D volume can be manipulated as in other tabs. 
 
Axial, Endoscopy layouts: These views display nine z-axis slices that can be scrolled through axially. Green lines 
corresponding to each of the slices are visible in the sagittal and coronal slices. 
 
Lateral layout: These views display nine z-axis slices that can be scrolled through laterally. Green lines corresponding to 
each of the slices are visible in the axial slice. 
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Endo: Volume of Interest  

Creating a volume of interest (VOI) allows for focusing mainly on the tooth of concern and removes any surrounding material that 
may obsure the view. This process creates a region oriented around a particular tooth and generates the corresponding 2D slices 
aligned with the tooth axes.  

To start, click on Select Tooth.   

 

The cursor transforms into a “+” shape, and clicking on a 2D slice or the 3D volume places a box. 

 

The box can be adjusted with the widget in the 2D slices. Click and drag the box to move it. Click and drag the yellow nodes to 
resize it. Click and drag the arrows to rotate it. Press the “a” key to realign the box to the slice.  

Once the box is positioned properly, click Apply or right-click to segment the VOI. Clicking on Select Tooth again allows for 
editing the current VOI or creating a new one. The Freehand Sculpture and Polygon Sculpture tools can be used to further sculpt 
out unwanted portions of the volume. Reset restores the starting volume. 
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The different View Presets can be applied to the volume by clicking on the desired preset: 

 

Sculpted volume with Pulp View Preset. 
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TMJ View Features 
The TMJ View Tab displays two independent focal troughs generating cross sections of each TMJ, along with 
corresponding coronal and axial views. The TMJ View Tab also displays the TMJ in 3D volume rendering options. 
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TMJ: Toolbar 

Shown below are the Toolbar and tools that are loaded with the TMJ View Tab: 

    

 
Reset: Resets the rendering window to the original view. 

 

Create Arch Spline: Select this tool to create or edit the spline. Left-click to place the first point and 
continue left-clicking along the structure. Right-click or double-click to finalize the spline. To modify an 
existing arch spline, drag the nodes to the desired positions. To move the arch while maintaining its shape, 
click and drag the central spline. 

 
Arch Spline Ruler: Places ruler along the arch spline for easy reference. 

 
Distance Measurement: After selecting this tool, click two points to mark the desired distance. A number in 
millimeters automatically displays. 

 
Angle Measurement: After selecting this tool, click the first point, then click the vertex, then click the last point 
to create an angle. A number in degrees automatically displays. 

 
Area Measurement: After selecting this tool, click multiple points along the boundary of the desired area. 
Double-click or right-click to end the measurement. A number in millimeters squared is automatically displayed. 

 
Reorientation: Adjust the patient orientation and the visible range of the scan. 

 
Arrow Notation: Allows an arrow to be drawn on the image. 

 
Circle Notation: Allows a circle to be drawn on the image. 

 
Text Notation: Allows text to be written and edited on the image. 

 

H.U. Measurement: Calculates the HU value of an area within a bounding rectangle, circle, or ellipse. The 
measurements display alongside the shape and can also be repositioned by dragging. The information 
updates when the box is moved. 

 

Slice Capture Mode: Opens the Slice Capture Manager to enable the capture of slices or groups of slices 
from a series of cross sections. Requires the creation of a slice group in the Report Tab and an activated 
Report module. 

 
Layout: After clicking on the layout icon, a list of various layout options appears. Click on the desired 
layout to apply it. 

 
Grid: Toggles between two different grid layouts for use in all of the section frames allowing quick 
assessment of measurements and spatial location. 

 
Toggle Cursor Visibility: Conceals or displays cursors. 

 
Information Display: Displays or hides case information embedded in the data. 

 
View Sequence: Opens a dialog that provides view sequence presets to create a video. 

 

 

Warning:  InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
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measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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TMJ: Control Panel 

 

Layout 
• Change Layout: Switch to different layout options. 
• “Print Out”  mode shows the image in life size and allows 

for capturing and printing in life size if captured to Gallery 
tab. 

Lateral Slices 
• “Width” changes the width of the slices. 
• “Interval” changes the interval between the cross-sectional 

slices. 
• “Thickness” adds multiple slices together for ray sum 

visualizations. 
Frontal 
• Change the visualizations of the coronal slices of the TMJ. 

o Slice – Gray Scale rendering 
o X-ray – X-ray rendering 
o Vol1 – Teeth rendering 
o Vol2 – Bone rendering 

• Use the Thickness drop-down to create a ray sum view. 

View Control 
• Use Brightness & Contrast to adjust the image. 
• The “All” drop-down allows for adjusting the brightness/contrast in different areas independently. 
• Color Presets allows better visualization of certain anatomic structures, soft tissue profiles, airway, etc. The color 

rendering is only for visualization. The colors are based on densities but DO NOT represent the density value of 
the bone.  

• Sharpening Filter: Applies the selected sharpening filter from the drop-down menu to the 2D slice renderers. 
Focal Trough 
• Click on the “Symmetry” box to keep the focal trough angles symmetrical. 

Save View Settings 
• Saves the current 2D View settings to be reloaded upon opening any case. See the Display Preferences 

section in Preferences for more information on which settings are saved for this specific tab (pg. 21).  
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TMJ: Rendering Window 

 

Please refer to Image Navigation (pg. 39) for information about controlling and adjusting these images. 
 
Arch Spline (Focal Trough) Navigation 
 

• Endpoints: Clicking and dragging either endpoint of the focal trough can shorten/lengthen the focal trough or rotate 

the focal trough, depending on the direction that it is dragged.  

 
Warning: Sequence direction depends on the focal trough direction. Medial and lateral may be flipped if the focal 
trough angle is in the opposite direction. 

• Cross Section Indicators: Clicking and dragging the stack of green lines scrolls the cross sections through the focal 

trough in that direction. 

• Focal Trough Box: Clicking and dragging any one of the lines forming the shape of the focal trough moves the 
entire focal trough. 
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TMJ: Layout 

 

 
 
Many of the various layout options of the TMJ Tab feature frontal views of the condyle. Some layout features include: 
 

• Two frontal volume views for each condyle, as seen above. 

• Free rotation of the volumes after Vol1 or Vol2 have been activated. 

• Sculpting operations carry over from Volume Render: The condyles can be segmented out using sculpting tools in 

the Volume Render Tab. These operations are carried over automatically to the TMJ Tab. 
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Superimposition View Features 
In the Superimposition View Tab,  open two different scans at once, view them side by side, and superimpose 
them. This is especially useful for assessing pre- and post-treatment scans. 
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Superimposition: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Superimposition View Tab: 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume, and the distance appears. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press the “delete” 
key to delete it. Control Panel features in Volume Render Tab allow the values to be projected to 2D, hidden, or 
exported to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between them 
appears. Clicking on their control points and moving the cursor can modify measurements. Click on the 
measurement and press the “delete” key to delete it. Control Panel features in Volume Render Tab allow the 
values to be projected to 2D, hidden, or exported to a report. 

 

Area Measurement: After selecting this tool, click multiple points along the boundary of the desired area. 
Double-click or right-click to end the measurement. A number in millimeters squared is automatically displayed. 
Control Panel features in Volume Render Tab allow the values to be projected to 2D, hidden, or exported to a 
report. 

 
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label and press OK. 

 
Point Registration: This icon is used to register the original volume to the second volume. Four or more 
anatomical points are chosen from each scan to properly align both scans at common, stable landmarks. 

 
Volume Registration: This icon is used to open the Volume Registration interface for automatic superimposed 
volume registration. Users define a VOI (Volume of Interest) Box as a reference for automated superimposition. 

 
Manual Registration: This icon is used to make adjustments to better align the two volumes that are 
superimposed. 

 
Layout: Toggles the rendering window layout. 

 
Grid: Toggles between two different grid layouts for use in the upper two section frames allowing quick 
assessment of measurements and spatial location. 

 
Toggle Cursor Visibility: Toggles on/off the cursor lines in the 3D volume rendering. 

 
Information Display: Displays or hides case information embedded in the data. 
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Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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Superimposition: Control Panel 

 

Superimposition Target: 
• Select Import New Volume to import a second volume. 

Superimpose either an Invivo file (.inv) or DICOM (.dcm) 
scan set. Multiple scans can be loaded. 

• Toggle on Enable for registration to use either Manual, 
Point, or Volume registration tools to align the scans or 
select the corresponding tools from the toolbar.  

• Select Mirror Own Volume to mirror the patient's anatomy 
to check for asymmetries. 

• Synchronized Layout can be toggled to display the volumes 
side by side. 

Volume 1 and Volume 2: 
• Imported and mirrored volumes are added into the drop-

downs. 
• Visible turns on/off either volume independent of each 

other. 
• View Control sets different visualization presets for the 

volume that allows better visualization of certain anatomic 
structures, soft tissue profiles, airway, etc. The color 
rendering is only for visualization. The colors are based on 
densities but DO NOT represent the density value of the 
bone.  

• Models allow the visualization or hiding of the models 
available to the respective volume. Model coloring differs 
between Volume 1 and Volume 2 models for visibility. 

• The Brightness and Contrast in the volume renderings can 
be adjusted independently and improve the image. 

Clipping: 
• Select “Enable” to slice the image along predefined 

anatomical planes (sagittal, coronal, axial). 
• Select “Flip” to switch the view to the opposite side. 
• Control Clipping with the scroll mouse or slider. 
• Custom: This option places the clipping plane at a custom 

position and orientation. 
• Modify Custom Plane: Allows the user to modify the 

position and orientation of the clipping plane. 

Visibility Toggle: 
• Volume: Adjust the opacity of the original volume and superimposed volume. Set the slider in the middle to 

visualize both volumes in equal opacity. Set the slider to one side to visualize only one image. 
• Slice: Adjust the opacity of the original gray scale slice and superimposed one. Set the slider in the middle 

to visualize both volumes in equal opacity. Set the slider to one side to visualize only one image. The Slice 
Color button displays the available slice color options. 

Load Superimposition: 
• Reload saved superimposition data. 
• Select Load and choose the correct .vdata file. 
• The superimposition file is reloaded with the saved volume. 

Save Superimposition: 
• Save the superimposition data into an external file. 
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• In the dialog that appears, choose where and what filename to save. 
• Invivo saves two files: .vdata and .odata 
• .vdata: stores the registration points and superimposed volume information 
• .odata: stores the original scan's volume orientation information 
Annotation:  
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off by selecting “Visible.” 
• Layout: Sorts all added comments in the rendering window based on selected setting (Horizontal, Stick to 

Point, User Dragged, Vertical, Vertical Even Distributed, Vertical Round Distributed). 
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Superimposition: How to Superimpose Two Volumes 

Invivo provides easy-to-use tools for superimposition. Although they are easy to use, superimposition is a technique-sensitive 
procedure with the most critical step being the registration of the new scan via the selection of stable landmarks in both scans. The 
proceeding sections discuss how to superimpose two scans step by step. 
 
Step 1: Open First File. Open one of the files for superimposition. Files do not need to be opened in a specific order, but starting 
with the pre-treatment scan may be recommended for sake of organization. See DICOM and Invivo File Loading (pg. 28) section 
for instructions on opening an Invivo file. 
 
Step 2: Import Volume. Go to the Superimposition Tab and from the Control Panel, click on the Import New Volume option to 
select the second file to open. The File Manager appears for loading either a DICOM file or an Invivo file. 
 
Step 3: Select the Point Registration tool. It can be found in the Superimposition Toolbar. 
 

 
 
Step 4: Registering the Two Scans to Each Other. In order to superimpose the scans as correctly and precisely as possible, strict 
attention must be placed in selecting at least four matching and stable landmarks in both scans. 
• To select landmarks on each volume: 

o Press down on the center scroll-wheel of the mouse. 
o Or, position the mouse over the landmark and press the space bar on the keyboard. 

• Select the first stable landmark on one scan using either method above. 
• Select the matching stable landmark on the other scan using either method above. 

o Each point shows up as either a blue or red dot. 
o Points are numbered for easy reference. 
o Points can be undone by pressing Ctrl + Z. 

• The volume can be rotated using the left-mouse button as before. 
• The volume can be clipped by selecting Clipping: “Enable” in the Control Panel. 
• The volume rendering presets can be adjusted using the Preset button. 
• Use caution in setting the Brightness and Contrast settings. 

o Be sure the Brightness and Contrast settings for the original and imported volumes are similar. 
o Be sure to use the similar Preset settings when registering points. 
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The image above shows a registration point (Registration Point 1) located on the anterior point of the right 
zygomaticofrontal suture. The point has been added to both the original scan (white, left) and the new scan 
(blue, right). 

 
 
Step 5: Save Points and Finish Registration. Once all points are plotted one by one, click the right-mouse button to register the 
two scans. Practice registration by superimposing the same scan before trying to superimpose two different scans. The precision of 
the superimposition can be assessed by examining the two registered scans overlap using the 2D and 3D toggle tools. 
 

  

(a) (b) 

(a) The above image on the left is of two identical data sets that are registered to each other 
precisely. Notice there are no overlapping areas of different colors. 
(b) The image on the right is of two volumes not registered precisely. Notice the blue and white 
skeletal boundaries do not line up, and the presence of double images. 
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Superimposition: Using Registration Widget for Fine Adjustments 

After finishing the landmark registration, the other tools provided in the Superimposition Toolbar can be used to make final 
adjustments to the superimposition. 
 

 
To make the cross sections bigger, use the Layout icon from the Toolbar 

 
To move the volume manually, use the Manual Registration icon from the Toolbar to display the 
move widget on the superimposed volume 

 
The above tools are available for use prior to using the Landmark Selector; however, it is strongly recommended to first use the 
Point Registration tool before using the Manual Registration tool. 
 
 
Check the cross sections for accuracy by adjusting the Layout (Layout icon) and the 2D Gray Scale Toggle slider. The 
superimposition is shown in 3D as well as in the cross sections. Make the necessary adjustments. 
 
 

 

For example, notice in the sagittal section shown to the 
left that the superimposed volume is not totally 
overlapped. Using the Manual Registration tool, move 
the volume in the anterior-posterior direction until the 
sections align by clicking on the yellow arrow in the move 
widget and dragging it forwards or backwards. 
 
 

 

One should go through each anatomical plane to check for 
precision. The cranial base should match up perfectly 
because it is stable; however, the vertebrae are usually off 
because the patient's head is always tilted somewhat 
differently in each scan. 
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Superimposition: Using Volume Registration for Fine Adjustments 

After finishing the landmark registration, the other tools provided in the Superimposition Toolbar can be used to make final 
adjustments to the superimposition. 
 

 
To make the cross sections bigger, use the Layout icon from the Toolbar 

 
To fine-tune the registered volumes, use the Volume Registration icon from the Toolbar to open the 
Volume Registration interface 

 
The above tools are available for use prior to using the Landmark Selector; however, it is strongly recommended to first use the 
Point Registration tool before using the Volume Registration tool. 
 
 
Select the Volume Registration icon in the toolbar to open the Volume Registration interface. 
 
Left-click on any of the 2D cross sections to place the center of the VOI (Volume of Interest) Box. The VOI box can 
be moved at any time by clicking and dragging it to another location in one of the 2D cross sections. 
 

 

Target Volume Size: 

• R-L Size: defines the lateral width (mm) of the 
VOI Box. 

• A-P Size: defines the anterior-posterior width 
(mm) of the VOI Box. 

• H-F Size: defines the inferior-superior height (mm) 
of the VOI Box. 

• Press Update Size to show the updated VOI Box 
size in the rendering window. 

• The bounding box may also be edited in the 2D 
view by clicking and dragging either the boundary 
lines or the corner nodes. 

 
Select Perform Registration to run the automatic registration process for the VOI Box selected. The process 
time is based on the computer's hardware components; however, in general, the larger the VOI Box, the more 
time is required to complete the automatic registration. 
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The following images show the VOI Box applied near the cranial base of a pre- and post-surgery superimposed scan 
(top image) and the results of the automatic registration process (bottom image). 
Notice that the two cranial base profiles line up exactly following the automatic registration process. The VOI Box used 
is the default (x, y, z) = 50mm x 50mm x 40mm. 
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Superimposition: Difference Between .vdata Files and .odata Files 

After successfully registering a different scan to the original volume data, Invivo can save the superimposition data using the Save 
Superimposition button. This section looks to further define the difference between the output files (.vdata and .odata) and how to 
use them. 
 
.vdata 

Information stored in the .vdata file includes the registration points and the path for finding the superimposed scan data. After  re-
opening the original scan, in the Superimposition Tab, press the Load Superimposition button and load the desired .vdata file. 
This loads the superimposed image in the correct position without having to re-register the landmarks. 

 
.odata 

Information stored in the .odata file includes the orientation information of the original scan data (not the superimposed scan). 
With this information, the specific orientation can be set for other cases as well. 
 
To import a new orientation, go to File in the Menu Bar and select “Import Orientation.” Choose the desired .odata file, and the 
case automatically reorients itself. 
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Model View Features 
The Model View Tab allows the user to see the patient's InvivoModel or 3D photograph and create surgical or 
orthodontic simulations, as well as 3D soft tissue predictions. An InvivoModel is a 3D digital study model that is 
made by Osteoid on a case-by-case service. The DICOM data of the patient is sent to Osteoid where it is modeled 
to create the most advanced digital study model available. InvivoModels contain anatomy such as roots, 
developing teeth, impactions, alveolar bone, and more, while other models merely show the crowns of teeth. The 
3D photograph service that Osteoid offers is also viewed here. Osteoid developed the technology to combine a 
frontal photo of the patient and the CT scan to create a 3D model that overlays the scan data. 

Any nerve tracing, implant planning, or superimposition that has been done is also be visible in the Model Tab. 
Each item can be independently turned on/off to see how all these systems come together with the scan data. 

 

For additional information about the InvivoModel service, please contact Osteoid at (408) 333-3484 or email us at 
info@Osteoidinc.com  
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Model: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Model View Tab: 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 
Slice Explorer: Once activated, clicking on a point on the volume opens a 2D zoom window in that location. 
The zoom window can be scrolled through using the mouse wheel. 

 

Marker: Select this option to mark a point on the volume and X, Y, Z coordinates (axial, sagittal, vertical) 
appear. Clicking on the point and moving the cursor can modify points. Click on the point and press the “delete” 
key to delete it. Control Panel features allow the values to be hidden or exported to a report. 

 

Distance Measurement: Select this option and mark two points on the volume, and the distance appears. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press the “delete” 
key to delete it.  

 

Angle Measurement: Select this option and mark three points on the volume and the angle between them 
appears. Clicking on their control points and moving the cursor can modify measurements. Click on the 
measurement and press the “delete” key to delete it.  

 

Polyline Measurement: Select this option and mark any number of points in the slice view. Right-click to end 
the measurement, and the total distance appears. Clicking on the nodes and moving the cursor can modify points. 
Click on the measurement and press the “delete” key to delete it. 

 
Comment Marker: Pick a point in the volume and enter comments. Type the desired text label and press OK. 

 
Model Color: Allows for the model color to be changed 

 
Grid: Toggles between four different grid layouts for simple assessment of size, measurement, and spatial 
location. 

 
Information Display: Displays or hides case information embedded in the data. 

 

View Sequence: Allows for the creation of custom camera sequences for movie capturing. Refer to the Volume 
Render Tab: View Sequence (pg. Error! Bookmark not defined.) section for additional information and 
description. 

 
Settings: Change the camera project in 3D, the composite layout type, life size display, annotation layout, and 
model visibility. 
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Warning:  InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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Model: Control Panel 

 

Layout: 
• Normal shows the digital models in the normal patient orientation 

along with the volume rendering if desired. 
• Occlusal shows both arches from the occlusal perspective. 
• Composite shows a composite of multiple views of the model all at 

once. 
Models: 
• Models: The individual, digital models (implants, abutments, 

restorations, nerves, teeth, superimposition) can be turned on or off 
in the rendering window.  

• Selected models’ colors can be changed by right-clicking to open 
the Model Color dialog. 

• Skin Opacity: Controls the opacity of the Skin model from the 
InvivoModel service or from 3DAnalysis. 

• Jaw Opacity: Controls the opacity of the alveolar bone/ ABO base 
from the InvivoModel service. 

• The Airway checkbox toggles the visibility of the airway 
measurement if one has been generated in the Airway Tab. 

• Show All and Hide All toggle the visibility of all the listed models. 
• Settings: Control settings for items in the Models list. A model 

must first be selected in this list before the button is pressed. 
Volume: 
• Select “Visible” to toggle the volume rendering on or off with the 

digital models. 
• The View Control buttons allows volume rendering options, such 

as Soft Tissue, Teeth, etc. that allow better visualization of certain 
anatomic structures, soft tissue profiles, airway, etc. The color 
rendering is only for visualization. The colors are based on 
densities but DO NOT represent the density value of the bone.  

• The Brightness & Contrast of the images can be adjusted with the 
slider. 

Clipping: 
• Select “Enable Clipping” to slice the image along the predefined 

anatomical planes (sagittal, axial, coronal). Control the clipping 
with the scroll mouse or the slider. 

• To switch a view to the opposite side, select “Flip.” 
• Custom: This option places the clipping plane at a custom position 

and orientation. 
• Modify Custom Plane: Allows the user to modify the position 

and orientation of the clipping plane. 
View Presets: 
Preset toggles that display predetermined views. A custom view can also be set. 
Simulation: 
To create a new simulation: 
• Select either the TeethMovement or JawMovement simulations, or press Edit to create a new simulation. 
• Move the slider to the right to indicate the ending point. 
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• Click on a digital model to move it (either individual teeth or whole arches) with the move widget.  
• After the final position is reached using the 3D move widget, press Start to go back to frame one. 
• Press Play to view the simulated movement. 
• Manage Keyframes lists the frames that compose the simulation for the selected model. (See page 120.) 
• Press Soft Tissue Prediction to create a simulation of the soft-tissue prediction. This is only possible with 

the use of a 3DAnalysis face photo or InvivoModel Skin. 
Annotation:  
• Edits selected comment/annotation in the text field. 
• You can toggle added comments on/off by selecting “Visible.” 
• Layout: Sorts all added comments in the rendering window based on selected setting (Horizontal, Stick to 

Point, User Dragged, Vertical, Vertical Even Distributed, Vertical Round Distributed). 
  

 
Warning: Soft tissue prediction is an approximation and may not reflect actual results. 
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Model: Rendering Window 

 

This window allows the viewing of InvivoModels, 3D photographs, and simulation, all of which are services that must be ordered 

per case for this feature to work. These services provide excellent diagnostic data and case presentation material. 

 
Please refer to Image Navigation (pg. 39) for information about controlling and adjusting these images. 
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Model: Custom View Preset Setup 

Visibility presets allow for easy switching between set views. Each option can be adjusted by the user. To configure these settings, 
click on Setup. 

 

• Visibility checkboxes hide or show features in the rendering 
window. 

• Skin Opacity: Controls the visibility of the face photo wrap 
from the InvivoModel workup file or 3DAnalysis. Varying 
degrees of transparency can be obtained with the slider. 

• Jaw Opacity: Controls the visibility of the jaw models. 
Varying degrees of transparency can be obtained with the 
slider. 
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Model: Simulations 

Simulations may be created using any of the model objects in the software, such as implants and restorations, as well as models 
created by the InvivoModel service. 

 

Adding and Deleting Simulations 
• Click Edit to open a list of all simulations. 
• In the Name field, input the name of the new simulation and click Add. 

The new simulation appears on the list. 
• To delete a simulation, click on the simulation on the list to select it, then 

click Delete Selected. 
• Initial Selected sets the current view state as Frame 0 for the selected 

simulation. 
• If “Edit 0 Frame” is checked, then the initial frame of the simulation 

becomes editable. 

 

Creating Simulations 
• Move the slider to Frame 100. This is the end state of the model. 
• Select a model and the move widget should appear.  
• The move widget can be repositioned along the model by using Ctrl + 

click and drag. 
• Use the move widget to adjust the final position of the model. 
• Moving the slider (Frame 0 to 100) moves the model between the initial 

and final positions. 
• To adjust intermediate model positions, move the slider to an 

intermediate frame (between Frame 0 and 100). Use the move widget to 
adjust the model position. 

• Moving the slider (Frame 0 to 100) moves the model from the initial 
position, through intermediate positions, and to the final position. 

 

Managing Keyframes 
• Any animation frame in which a model position was adjusted becomes 

a keyframe. 
• Keyframe management allows for preexisting keyframes to be easily 

identified, edited, or deleted as well as the creation of new keyframes. 
• Click on Manage Keyframes to display a list of the keyframes for the 

selected model. 
• The position of the model at existing keyframes can be edited by 

selecting the appropriate frame and repositioning the model. 
• To insert keyframes, move the slider to the desired frame number and 

then click Insert. The model may then be moved to create a new state 
for that frame. 

• To delete keyframes, click on the keyframe on the list and then click 
Delete. 

Note: Manage Keyframes does not apply to skinwrap. 

Please see page 131 for more information on InvivoModels and simulations.  
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Gallery View Features 
The Gallery View Tab archives images that have been captured from other tabs. Additionally, images can be 
imported into Invivo or exported to a desired filepath. Comments or notes can be added to describe images that 
have been captured. 
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Gallery: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Gallery View Tab: 

 

 
Crop Image: Crop captured images to save as new images or replace the original. 

 

Gallery: Control Panel 

 

Images: Gives a list of all captured images. 

• Each of these images has a “Name” and “Type” which can be renamed by 
double-clicking on the text. 

• Move Up/Down: Moves the selected image up or down on the list. 
• Crop Current: Crop the currently selected image within Invivo. 
Image Operation 

• All/Selected: Applies operation to all or a subset of the images from the list. 
• Remove: Removes images from the Gallery. 
• Export: Export the images in the Image List to a path specified in the dialog 

box that opens or to PACS if configured. Local files can be saved as one of the 
following formats: .jpg, .bmp, or .png. PACS files are stored as DICOMs. 

• Email: Email the images in the Image List as attachments from the set email 
account to the recipient’s email address. An email subject line and message 
can be included. 

Import Images: 

• Select to import images (.jpg, .bmp, .png) from an external source into the 
Gallery Tab. 

• Using this, patient photographs or 2D DICOMS can be imported into the 
Invivo software for storage within the Invivo file once saved. 

Comments: 

• Text box displays comments about the image displayed in the rendering window. 
• Add or change comments by editing the text in the Comments Box. 

2D Image Options: 

• Controls settings for 2D images. See more information in Gallery: 2D Image Options. 
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Gallery: Rendering Window 

This window allows the viewing of captured and imported images. The Gallery is particularly useful for creating a workup of a 
particular case. Remember that the Gallery’s images are only saved if the file is resaved; otherwise, any captured images will be 
lost. 

 

 
 
Please refer to Image Navigation (pg. 39) for information about controlling and adjusting these images. 
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Gallery: Adding Images to the Gallery 

Capture any single image to the Gallery. A single image within any view can be captured without including the other parts 
of the rendering window. When the Capture to Gallery function is used, a dialog appears on the screen providing the user 
with options regarding which parts of the rendering window to capture.  
 
The options provided by each dialog varies according to which Invivo tab is currently displayed; the following example is 
the dialog that appears within the ArchSection Tab: 
 

 
Ex. ArchSection Capture to Gallery 

Capture to Gallery Dialog: 

• Whole View – Captures a screenshot of the 
rendering window 

• Axial – Captures the axial slice view and no 
other parts of the rendering window 

• Pano – Captures the pano view and no other 
parts of the rendering window 

• Cross Sections – Captures a series of slices 
that are within the rendering window 

 
Options within each Select Image to Capture Dialog: 
Note: Some options appear gray (disabled) in the Select Image to Capture dialog. The choices available are determined by 
the specific layout as well as the view tab. 

 

Section  Whole View 
 Axial, Coronal, Sagittal Slices 
 Custom Section (Displays Custom Cross Section or 3D 

Volume) 
 

Volume Rendering No Dialog 
 

ArchSection  Whole View 
 Axial 
  

 Pano 
 Cross Sections 

Super Pano  Whole View 
 Pano 
 Front Volume 

 Axial 
 Preview Pano 

Super Ceph  No Dialog 

Airway  Whole View 
 Axial 
 Sagittal 

 Airway 
 Volume 

Endo  Volume Layout  Whole View 
 Volume 
 Axial 
 Sagittal 
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 Coronal 

 Axial Layout  Whole View 
 Axial Slices 
 Axial 
 Sagittal 
 Coronal 

 Lateral Layout  Whole View 
 Lateral Slices 
 Axial 
 Sagittal 
 Coronal 

 Endoscopy Layout  Whole View 
 Endoscopy 
 Axial 
 Sagittal 
 Coronal 

TMJ  Whole View 
 Axial 
 Left Frontal 
 Left Frontal 2 

 Left Cross Sections 
 Right Frontal 
 Right Frontal 2 
 Right Cross Sections 

Superimposition  Whole View 
 Main Volume 
 Axial 

 Coronal 
 Sagittal 
 Imposed Volume 
  

Model Normal Layout No Dialog 

Occlusal Layout  Whole View 
 Lower Occlusional 
 Upper Occlusional 

Composite Layout  Whole View 
 Composite 1-9 
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Capture to Gallery Dialog: 

 

 

 Name: Image label 
Note: Image name must be unique from 
any other captured image in the Gallery 
and must not contain any special 
characters. 
 

 Type: Image type – can be set from the 
drop-down to “Captured” or “Photo.” 

  
 Comments: Additional comments about 

the image can be added in this section. 
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Gallery: 2D Image Options 

The Gallery Tab is compatible with 2D DICOM images and has several features that allow it to handle this image format better. 

Opening 2D DICOM 

When instructed to open a 2D DICOM image, Invivo automatically enters a mode that disables 3D functionality. Only 
the Gallery Tab is available within the software, and the DICOM appears as a Gallery image. 
 
If a 2D DICOM is associated with a 3D volume as a scout image, opening the volume automatically imports that scout 
image into the Gallery Tab. 
 

 
Grayscale Image Options 
 

For grayscale images in the Gallery, the user has the option 
to adjust several settings such as Gray Scale Threshold, 
Brightness, Contrast, and Sharpening.  
 
The updates to these images are saved and always reflect 
the updated settings when the image is selected in the 
Gallery and also after it has been saved/exported and then 
opened/imported back into Invivo.  
 
 

 

 
Export to DCM/JPG/PNG/TIF/BMP 
 

An image in the Gallery can be exported into any of the 
above formats when using the Export… button. When 
saving individual Gallery images to file, the following 
image formats are available (JPG, PNG, BMP).  
 
An image in the Gallery can also be exported to PACS as 
a series.  
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Common How to Tasks 
How to Trace a Nerve 

• Go to the ArchSection Tab. 

• Make sure the pano is in Slice Mode (not X-ray mode). 

• Adjust focal trough such that the nerve pathway is visible in pano image. 

• Move pointer to the pano image. 

• Review the nerve pathway while using scroll wheel.  

• If the nerve pathway is not clearly visible, adjust the focal trough. 

• When the nerve pathway is identified through the pano image, press New Nerve in the Control Panel. 

• Starting from the mandibular foramen, click point by point. 

• If the nerve pathway is not clearly visible, use the mouse scroll wheel to find the nerve pathway and continue 

picking. 

• Near the mental foramen, move the mouse to cross-section view. 

• Use the scroll wheel to find the exit of the nerve. 

• Pick points connecting the nerve exit. 

• Press Done in the Control Panel to finish the nerve. 

 

 

 

Warning: Any nerve that is traced in a way that does not conform to the actual pathway of the nerve can lead to surgical 
complications if diagnosis, treatment plans and/or actual treatment is based off of the incorrect tracing. It is critical for 
the end user to learn how to properly perform nerve tracings correctly. If you notice any inconsistencies or software 
problems with nerve tracing or have further questions or concerns about nerve tracing, please contact Osteoid support 
at (408) 333-3484 or email us at info@Osteoidinc.com 
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How to Create Reports in Life Size 

• Go to ArchSection Tab. 

• Select Reorientation button in the toolbar 

• Adjust upper and lower limit by dragging green lines and then click Reorientation button to exit. 

• Adjust focal trough (arch spline) or re-draw arch spline by the clicking the Create Arch Spline button. 

• Change Layout Mode to “Print Out.” 

• Change to a desired layout using the Change Layout button. 

• Adjust cross-sectional width and interval. 

• Move cursor to set cross section in desired location. 

• In Print Out mode, user cannot zoom the image since it is set to life size. 

• If desired structure is not visible in cross section, adjust axial cursor or focal trough. 

• Switch pano image to X-ray mode and turn on the ruler. 

• Turn on the Arch Spline Ruler and turn off arch spline control points. 

• Turn off the cursor if necessary by clicking Toggle Cursor Visibility. 

• Go to the View menu and choose “Capture to Gallery” or press Ctrl + G 

• Go to Gallery Tab. 

• See Print Preview in the File menu and print out a test page. 

• To change the format, go to “Print Layout Setup” in the File Menu. 

• To use a personal logo, replace the “printLogo.png” file in installation folder. This folder is typically in “C:\Program 

Files\Anatomage\InvivoVet” 

• If the Print Layout Setup is changed, choose Print Out mode before recapturing the image. Otherwise the image could 

still be in the previous Print Layout Setup. 

Other View Tabs with Life-Size Printing 

• Non-whole view, full-screen Section render (double-click a renderer to make full screen) 
• TMJ in Print Out mode (Axial slice is not life-size) 
• Pano in Super Pano 
• Super Ceph in Print Out mode 
 

 

Warning: InvivoVet’s measurement functionality has been verified to be accurate up to +/- 0.10 mm. However, 
measurement accuracy depends on the image data and the hardware scanner that generated the image data. The 
measurement cannot be more precise than the resolution of the image. Software reports the value based on user-picked 
points. Due to the nature of medical imaging, the boundary is not always well defined. The apparent boundary depends 
on the current brightness and contrast setting. The boundary may shift as the user makes adjustments to brightness and 
contrast. The user must understand the limitation of the measurement value before applying to the patient. Any 
measurement that is incorrect can lead to surgical complications if diagnosis, treatment plans and/or actual treatment 
is based on the incorrect measurements. It is critical for the end user to learn how to perform measurements correctly 
and employ proper usage of all measurement tools. If you notice any inconsistencies or software problems with 
measurements, or have further questions or concerns about using measurement tools correctly, please contact us at 
(408) 333-3484 or email us at support@osteoidinc.com. 
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How to Create a Positive Airway View 

• Go to Volume Render Tab. 

• Select the Inverse View Control. 

• Reduce the opacity such that the internal structures start to appear. 

• Change the viewpoint to Top View (Press Top button in toolbar). 

• Use Freehand Sculpture or Polygon Sculpture to remove the undesired parts of the volume. 

• Change the viewpoint and repeat sculpting operations. 

• After the desired airway is isolated, increase the opacity. 

• Adjust Brightness and Contrast to set the right visualization. 

• (The Airway Measurement tool in the Airway Tab also shows a positive airway view that is color coded based on area. 

This inverse method shows the airway without color coding.) 
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How to Create an InvivoModel Simulation and Video 

Simulations require the use of the InvivoModel service provided on a case-by-case basis from Osteoid. The InvivoModel service 
may include some or all of the following features: 
• Individually segmented, digital models of patient dentition 
• Segmented digital models of patient mandible and maxilla 
• 3D photograph overlay on the patient soft-tissue profile 
For additional information about the InvivoModel service, please contact Osteoid at (408) 333-3484 or email us at 
info@Osteoidinc.com. 

• Go to Model Tab. 
• Control Panel: Simulation, from the drop-down 

menu choose an existing simulation 
(TeethMovement, JawArticulation) or create a 
new one (select Edit). 

• Move the slider to the very end (Frame 100).  

 

• Select a model adjust and the move widget should appear.  
• Use the move widget to adjust the final position of the model. 
• Moving the slider (Frame 0 to 100) moves the model between the initial and final positions. 
• To adjust intermediate model positions, move the slider to an intermediate frame (between Frame 0 and 100). 

Use the move widget to adjust the model position. 
• Moving the slider (Frame 0 to 100) moves the model from the initial position, through intermediate positions, 

and to the final position. 
• The position of the models set on the frames can be editted through the Manage Keyframes option. 
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 View Sequence: 
• To create a video of the simulation, select the View Sequence button 

from the Model Toolbar to open the View Sequencer Window. 
• Much like the Volume Render View Tab (pg. Error! Bookmark 

not defined.), frames with various volume orientations, clippings, 
colorizations, etc can be inserted. 

• Adjust rendering window image to desired settings (orientation, 
volume colorization, etc.) and move the Simulation slider to Frame 
0. 

• Press Insert in View Sequencer window. 
• Adjust rendering window image to desired settings (orientation, 

volume colorization, etc.) and move the simulation slider to Frame 
100. 

• Press Insert in View Sequencer window. 
• Test the video using the Start, Play, and End buttons in the View 

Sequencer window. 

 

Movie Capture: 
• If needed, make any necessary changes (Insert new views or 

Modify/Delete existing views) until the simulation is as desired. 
• Once the  view sequence is finalized, select VIDEO Capture to 

open the Movie Capture Window. 
• Please refer to Volume Render Tab: View Sequence Section (pg. 

Error! Bookmark not defined.) for additional descriptions. 
• Capture the view sequence to save the simulation as an AVI movie 

file. 

 

 

  



 
 

     133 of 203                                 UM-VET-ENG-72A ANA003 Rev A  NOV 11th, 2025 PAGE 

            

Additional Modules 

 
 

  
 
 
 
 
 
 
The following modules are sold separately. To find out more information about these modules, please contact Osteoid at 
(408) 333-3484 or at info@Osteoidinc.com 
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Report Module Features 
The Report View Tab allows for the creation of templates containing images and text. A template can be applied 
to any case using this tab. In this picture, the page background is black and represents the page. Several types of 
items can be placed within this page to create a detailed report for the patient. 
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Report: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Report View Tab: 

 

 
Add Image: Adds a control to add a single image. 

 
Add Slices: Adds a control to add single slices or a group of slices. 

 
Add Text: Adds a control to add text. 

 
First Page: Navigates to the first page of the report. 

 
Previous Page: Navigates one page back. 

 
Next Page: Navigates one page forward. 

 
Last Page: Navigates to the last page of the report. 

 
Insert Page: Inserts a page after the current page. 

 
New Page: Adds a page to the end of the report. 

 
Remove Page: Deletes the current page. 

 
New Template: Creates a blank template. 

 
Export PDF: Saves the report as a PDF file. 

 
Export to PACS: Saves the report as a DICOM onto the PACS server. Requires PACS configuration 
beforehand. 

 
Preferences: Opens preferences for default colors, default image type, default page setup, and grid alignment. 
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Report: Control Panel 

 

Template 
• Template drop-down: Lists the available templates. 
• Manage: Displays all of the preset templates. Templates can 

also be loaded, renamed, and removed in this dialog. See pg. 
150. 

• Save: Saves the current template. Templates are stored 
locally and show up on the drop-down. 

Add New Control 
Text: 
• Edit Phrases…: Opens a dialog for managing common 

phrases to be added to text controls. See pg. 140. 
• Add Text: Adds a control for text. 
Slice Group: 
• Slice Group Management: Allows creation and 

management of image groups. 
• Add Slice Group: Adds a control for 2D slices. 
Single Image: 
• Add Single Image: Adds a control for one image. 
Current Control 
• Name drop-down: Shows the name of the currently selected 

control from a list of controls on this page. Each control can 
be selected from the drop-down menu instead of clicking the 
control. 

• Image Refresh: Updates the image according to the 
changes in the source image. 

• Properties: Opens the Properties window for the current 
control. 

• To Background: Puts the selected image behind other 
images. 

• To Foreground: Puts the selected image in front of other 
images. 

Page Control 
• Print Page: Enables the current page to be printed. 

• Page Setup: Opens page setup for setting printer, paper size, margins, and background/border properties of 
the page. 

• Page Information is displayed showing the current settings. 
• Previous/Next Page: Page navigation controls. 
• Delete Page: Removes the current page. 
• Insert Page: Inserts a page after the current page. 
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Report: Rendering Window 

 

The rendering window displays the report page and is the main area for designing and viewing reports and templates. The page 
navigation buttons in the toolbar allow the user to switch between pages in a multi-page report to choose which is displayed in the 
rendering window. 

Adjusting the position and zoom of the report within the rendering window uses the same keyboard and mouse combinations as in 
other Invivo tabs: 

Zoom – Ctrl + Left-Click + Drag Mouse 

Pan – Shift + Left-Click + Drag Mouse 
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Report: Controls 

Controls are boxes that display text or image data. 

 

Adding and Sizing 
• Navigate the mouse cursor to the Control Panel on the left 

and select the button labeled Add Text, Add Slice Group, 
or Add Single Image.  

• Size the control: The image on the left shows the control 
rectangle during creation. The control is created by two 
separate points and does not show up until after the first 
point has been placed.  

 

Warning: If the control is created outside of the page borders, an error 
message is displayed, and the control is not created. 

 

Resizing and Customization 
• After creation, the control looks like the image on the left.  
• Resize the control: Click and drag the green squares or the 

borders. Alternatively, set the height and width from the 
Properties window. 

• Move the control: Click and drag with the left mouse 
button or use the arrow keys on the keyboard after clicking 
inside the control. 

• Select a control: Click on the control or select it from the 
Name drop-down on the Control Panel. Pressing the Delete 
key deletes the control. To see the control's properties, press 
the Properties button while it is selected. Double-clicking 
the control also shows its properties. 

• Select multiple controls: Click more than one control while 
holding the “Ctrl” key on the keyboard. Supported multi-
control operations are movement and deletion. 

• Copy and paste controls: Select a control, press Ctrl + C, 
then press Ctrl + V to paste it at another location. 
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Report: Adding Text Controls 

Text Controls contain text that is manually typed in or drawn from the Case Info. 

Adding a Text Control: 
• Click the Add Text button. 
• Properties can be changed by clicking Properties in the Current Control section of the Control Panel. 

 

 

Text Box Dialog 
This dialog can be opened by double-clicking on a text control or 
selecting the control and clicking Properties on the Control Panel. 

Text 
• Alignment type: Select the text alignment type. 
• Font Options: Family, size, color, alignment, bold, and italics can 

be changed. 
• Text Input Box: Enter text to be displayed in this text box. 
• Insert Case Info: Inserts the selected data based on the case 

information or Gallery comments where the cursor is in the Text 
Input Box. 

• Insert Text Phrase: Inserts the selected text phrase where the 
cursor is in the Text Input Box. 

• Edit Phrases: Opens the Text Phrases dialog (See pg. 140). 

 

Box 
• Size and color: Determines the size of the text control.  
• Unchecking “Transparent” shows the chosen color instead of the 

report’s background color. 
• Border: Set the border style, color, and thickness. Style can be dashed, 

solid, or none (not displayed). 

 

Save As 
• Choose the name of the control. 
Show on Every Page 
• Check this option to show the text in the control on every page of 

the template. 
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Text Phrases 
Text phrases store common phrases within the software 
to be inserted into text controls. This dialog can be 
opened by click on Edit Phrases. 
• Search: Searches for the term in the list of stored 

phrases. 
• Add: Opens a dialog for creating a new phrase. 
• Edit: Opens a dialog for editing the selected phrase. 
• Remove: Removes the selected phrase. 
• Insert: Inserts the selected phrase into the text 

control. 
• Text Input: If a text control is selected, type directly 

into the box to update the text control on the report. 
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Report: Slice Group Management 

Groups are created in the Report Tab and used in slice controls. The groups are populated from ArchSection and TMJ Tabs only. 

 

Slice Group Management: To add/modify groups, click the 
Slice Group Management button in the Page section of the 
Control Panel. 

Add/Edit Group Name: Name of the new group or the new 
name of the selected group. 

Slice Type: Type of slice for this group. 

• Arch Axial Slice: ArchSection Tab’s axial slice mode 
• Arch Cross Slice: ArchSection Tab’s cross-section slice 

mode 
• TMJ Left Cross Slice: TMJ Tab’s left cross slices 
• TMJ Right Cross Slice: TMJ Tab’s right cross slices 

 

 

Description: Optional description for group. 

Add Group: Adds the new group to the template's groups. 

Edit Group: This replaces the selected group with the new 
group. If the slice type changes, all of the slices will be 
removed. If any slices in this group are not in other groups, 
they will also be removed from the case file. 

Remove Group: This permanently deletes the currently 
selected group from the current template. If any slices in this 
group are not in other groups, they will also be removed from 
the case file. 

Selected Group: This holds all of the existing groups on the 
template. Can be selected for Edit and Remove operations. 

The image on the left displays the corresponding slices for 
this particular Slice Group. 
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Adding Slices to a Group 
Note: Only the ArchSection and TMJ Tabs allow for capturing slices to a slice group. 

ArchSection and TMJ Tabs have a toolbar button (shown below) that enables the slice-capturing mode. While in this mode, all 
captured slices for a selected group are visible. Slices can be added or removed from the slice group. 

 
Slice Capture Mode – This opens a dialog for capturing slices to a group. 

Capture Slices Dialog: 

 

Capture Target: Allows selection of group to add/remove 
slices. All parameters are read-only here. The selection of 
slices can be modified in the Slice Group Properties in the 
Report Tab. 

• Name: Name of the current group 
• Type: The group's slice type 
• Description: Optional description for this group 

Action: Description of the capture slice options (discussed 
in more detail in the next section). 

Select Range: Allows use of the pano or frontal image to 
capture the slices. Press the Select Range button then pick 
two points on the pano to mark the start and end slices. All 
of the slices in between are added to the group. The number 
of slices depends on the slice interval and slice thickness set. 

 

Status: Allows viewing of all slices in this group. 

• Number of Captured Slices: List of all slices in the 
current group with a count of the total number 

• Remove Slice: Remove the selected slice(s) 
• Remove All: Removes all captured slices 

The image on the left displays the corresponding slice that 
would be captured with this Slice Group. 

Management 
• Manage Slice Groups: Opens the Slice Group Management dialog. 

 
Capturing Slices 

There are three ways to capture a slice in the capturing mode in the ArchSection or TMJ Tabs. All captured slices for the current 
group have their borders highlighted in green in the source tabs. Their locations are also marked on the pano and frontal images. 
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Arch axial slices are not marked on the pano. Note: For the arch axial slice type, ArchSection layout must be in lightbox mode with 
axial sections chosen for capturing. Slices outside the selected group's slice type cannot be captured. 

Slice Capture 

• Single Slice Capture: Hold the “s” key on the keyboard and left-click any slice to capture it. The selected slice is 
highlighted. Note: Repeating this deselects the slice. 

• Group Slice Capture: Hold the “a” key on the keyboard and left-click any slice to capture it. Click on another slice, 
and all slices in between the two slices are captured including the second slice clicked. 

• Select Range: This captures slices within a range designated in the pano or frontal images depending on the view. Note: 
This is not available for arch axial slices. 
 

 

The image above shows the configured slice range on the 
ArchSection pano. 

Note: If slices have already been captured to the Report Tab, 
white lines denoting these slices are visible on the pano even 
before the Select Range function is used. Use the Toggle 
Visibility tool to hide these lines. 

Select two points on the pano in ArchSection or the frontal 
images in TMJ. 

• After clicking once on the image, a red line appears. 
This is the starting slice of what is captured.  

• When clicked a second time, all slices between the 
red line and the second point are captured. A second 
red line marks the end slice. White lines denote every 
captured slice as defined by the cross-section 
parameters. See image to the left. 

• A gallery image with the slice group name of the 
pano or frontal is be added. If one already exists, it 
will be replaced.  

• Note: This automatically replaces any other image 
with the same name regardless of how it was 
captured to Gallery. 
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Report: Adding Slice Group Controls 

Slice Group Controls can hold a single slice or a series of slices. (See Report: Slice Group Management,  
pg. 144.)  

Note: If no slice groups exist, the dialog prompts to create one. 

Adding a Slice Group: 
• Click the Add Slice Group button.  
• Properties can be changed by clicking Properties in the Current Control section of the Control Panel. 

 

Warning: When resizing a Slice Group Control, note that the slice numbers may disappear if the control is downsized 
past a limit (approximately the size that the numbers can no longer fit within each respective slice). 

Slice Group Box Properties 

 

Source 
• Sync to Source: Select to update the image automatically if it is changed. If 

disabled, images can be refreshed with the Image Refresh button. 
• Slice Groups or Selections: Determines if slices are added by group or individually 

by slice. See the next page for more information on Slice Image Source. 

Layout 
• Columns/Rows: Determines the arrangement of slices within the control.  
• Note: If there are not enough rows and columns for the number of chosen slices, 

some slices are not displayed. 
Display Mode 
• “Fit” stretches the image to fit the control while maintaining aspect ratio. “Clip” 

uses clipping to fill the control space. 
 
Image Alignment: Determines how the image is oriented within the control. 
• See Image Alignment on pg. 148 for more details. 

Box 
• Size and color: Determines the size of the text control.  
• Unchecking “Transparent” shows the chosen color instead of the report’s background color. 
• Border: Set the border style, color, and thickness. Style can be dashed, solid, or none (not displayed). 
• Ruler: Set which borders rulers are displayed and the color. 
Save As 
• Choose the name of the control. 
Show on Every Page 
• Check this option to show the content on every page of the template. 

 

Slice Image Source Details: 

Images can be added to Slice Group Controls by group or by manual selection: 
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Slice Groups: Displays slices from a single group. 
Refer to Report: Capturing Slices (pg. 150) for more 
information on the restrictions and functionality of slice 
range. 
• Selected Group: The slice group to use as the source. 
• Start Slice: First slice to be displayed from the group.  
• End Slice: Last slice to be displayed. 
If “All” is checked, all of the slices from the selected 
group are displayed. 

  

 

Selections: Manually add captured slices one by one to 
be displayed.  
• Available Slices: All slices captured in the current 

case file. 
• Selected Slices: All slices chosen to be displayed in 

this control. 
• > Button: Moves selected Available Slice(s) to 

Current Slices for display. 
• < Button: Moves selected Current Slice(s) to 

Available Slices to no longer display. 
If “All” is checked, all of the captured slices are 
displayed.  
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Slice Control Selection Details 

Start and end slice are determined by their slice numbers. This number can be seen on each slice in the upper right. This is only 
enabled for single groups. When selecting the range of slices to be displaced, the number indicates which slice in the series is shown 
and does not correspond to the slice number itself. 

• Start Slice: What slice in group to start displaying. 0 defaults to the first slice. 
• End Slice: What slice in group to stop displaying. 0 defaults to last slice. 

 
Slice Range Examples: 

• The first two slices can be shown by setting Start Slice to 1 and End Slice to 2. The next two can be shown by setting 
the start to 3 and the end to 4.  

• All slices can be shown by setting Start and End Slice to 0.  
• If Start Slice > End Slice, only the End Slice is shown. 
• If Start Slice > Number of slices and End Slice = 0 or End Slice ≥ Number of slices, then only the last slice is shown. 
• If either parameter is blank, it defaults to 0. 
• If End Slice > Number of slices, the last slice is the End Slice. 
  



 
 

     147 of 203                                 UM-VET-ENG-72A ANA003 Rev A  NOV 11th, 2025 PAGE 

            

Report: Adding Single Image Controls 

Control that holds a single image from a selected source view. 

Adding a Single Image Control: 

• Click the Add Single Image button.  
• Properties can be changed by clicking Properties in the Current Control section of the Control Panel. 

 
Single Image Box Properties 

 

Source 
• Determines the exact image to be displayed from the 

source view (Note: Images are not  available until the 
specified source view has been “visited” to provide an 
image to load. See Report: Image Type Definitions, pg. 
149, for details on dynamic images.) 

 Sync with Source, Display Mode, Image Alignment, Box 
dimensions and properties, Save As, and “Show on Every 
Page” control the same properties as for Slice Groups (see 
Report: Adding Slice Group Controls, pg. 144). 

 
Warning: Bitmaps under 24 bit may not display 
correctly. 
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Report:  Image Alignment 

For Slice Group Controls and Image Controls, images may be aligned to the control boundaries by two methods.  

Fit: Resizes the image to fit within the borders of the control as determined by the Image Alignment settings.  
 

This example is done with a bottom left fit alignment position with a white background.  

 

The image originates from the bottom left and shows the background above it or to the right when it does not fill the control. 

 

 

Clip: The original image size is maintained. The control may need to be resized in order to display the full image.  
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Report: Image Type Definitions 

Dynamic Images: 

These images can always be up-to-date with the latest changes performed on them if desired. When adding an image to a control, 
the user can choose not to auto-update the image, keeping the current image until the auto-update setting is changed or the image 
is manually refreshed. There are two types of dynamic images. 

Note: Capturing images from specific layouts requires that the layout is currently selected when leaving the aforementioned view 
tab and reloading the Report Tab. Ex. The pano screen in the Implant Tab is not captured unless the Pano layout is on when leaving 
the view. 

• Single image view sources except Gallery and external images are dynamic. 
• To populate the image source with images, go to a view tab. After leaving the view, images for that view are 

captured. 
• After an image has been added to a control, it updates when changes are made in that view. For example, if a 

measurement is added to Section Tab's axial view, the image in the Report Tab now displays that measurement. 
• These images are saved with the case file. 

• Slice images 
• These are captured manually. 
• These are the input for the Add Slice Control. 
• They have the same dynamic update behavior as above. 
• These images are saved with the case file. 

 
Static Images:  

These images never change without manually change the source image. There are two sources of static images. 

• Gallery 
• All images in the Gallery are either captured from other tabs or imported by using the Import Images function. 

They may not always be life size. 
• These images are saved with the case file. 

• From a File 
• These images come from the local computer or another source. They are never life size. 
• These images are saved with the template. 
• If an image that already exists in the template is added, the software prompts whether to replace the image or keep 

using the older one. 
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Report: Managing Templates 

Once a report layout is created, it can be saved and reloaded in other cases as a template. These saved templates automatically 
appear in the drop-down menu. To display a preview of all the available templates or to edit them, click on Manage… on the 
Control Panel. 

 

Manage Preset Templates 
• All of the saved templates be shown here. 
• Each color represents a different type of control: 

• Blue: Text control 
• Red: Image control 
• Yellow: Slice group control 

• Templates may also be loaded from this window by left-
clicking on them. 

• Previous/Next: Goes to the previous or next page of 
templates, respectively. 

• Edit List: Opens a dialog for editing template properties. 
• Close: Closes the dialog. 

 

Edit Template Presets 
• Add: Load an existing template that was saved elsewhere. 
• Rename…: Rename the selected template. 
• Remove: Remove the selected template. 
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Report: Preferences 

 

Default Control Colors: Colors for border, background, 
font, and rulers. 
Default Image Type: Choose between “Fit” or “Clip” 
display modes. 

Default Page Setup: 
Printer: Printer in current use. This changes the available 
paper sizes. This list includes all of the printers available 
to the computer. 
• Paper Size: Uses the printer drivers to set the height 

and width of the page. 
• Orientation: Portrait or landscape setup. 
• Margins: Margins (in inches) for the template. Used 

for where controls can be placed. 
• Background: Color and transparent options. 
• Border: Color, thickness, and style options for the 

border. Styles are solid line, dotted line, or no line at 
all. 

• Margins: Margins for the border. This can differ from 
the page margins. 

Behavior: Specifies behavior of the template during design. 
• Enable Alignment Grid: If checked, all controls 

attach to their top left corner to the nearest grid point. 
If unchecked, they are placed wherever the user 
drags them. 

• Display Numbers on Print: If checked, the report 
page number is displayed in the printout.  

Alignment Grid: 
• Grid dot spacing: Defines the distance between grid dots. 
• Grid dot color: Set the color of the grid dots. 
• Hide Grid: Toggles the visibility of the grid. 
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Report: Page Setup 

This displays and allows configuration of the page settings. These are the settings the template uses. When printing, the correct 
printer and paper size must be chosen from the print setup.  

Note: The first time the software loads, the default printer configuration is used to set the printer and paper size for the report. Report defaults can 
be changed from the Preferences menu. 

 

 

Page Setup: 

To modify page settings, click the Page Setup button in the 
Control Panel. 

Page Configuration:  

• Printer: Printer to use for this template. 
• Paper Size: Current paper size. Only displays paper 

sizes for the currently selected printer. 
• Paper Orientation: Portrait or landscape orientation. 

(Note: Margins do not change, so paper may appear 
to have different proportions when switching 
between portrait and landscape.) 

• Margins: Margins (in inches) for the page.  

Background: 

• Checking transparent shows the chosen color 
instead of the background. 

Border: 

• Set the border color, thickness, and style. 
Style can be dashed, solid, or none (not displayed). 
• Margins: Location of the borders. 
 

Page information of the chosen configuration is always 
displayed in the Page section of the Control Panel. 
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Stitching Module Features 
The Stitching View Tab provides the ability to merge two DICOM data sets. This provides the ability to utilize 
CBCT machines with smaller fields of view fully. 

 
+ 

 
|| 

 

 
Warning: Stitching module is not a medical device and should be used as a reference or presentation tool only. 
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Stitching: Toolbar 

Shown below are the Toolbar and tools that are loaded with the Stitching View Tab: 

 

 
Reset: Resets the modeling window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 
Layout: Toggles the rendering window layout. 

 
Grid: Toggles between different grid layouts on the volume, allowing quick assessment of measurements and spatial 
location. 

 
Point Registration: This tool is used to register the original volume to the imported volume. Four or more anatomical 
points are chosen from each scan to properly align them.  

 
Adjust: This tool is used to make adjustments to align the two volumes better.  

 
Information Display: Displays or hides case information embedded in the data. 
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Stitching: Control Panel 

 

 

Import New File: Import the second volume by opening an invivo file 
(.inv) or DICOM (.dcm).  

Original Volume and Imported Volume: Different viewing options, 
such as visibility, rendering type, brightness, and contrast for each 
volume can be selected or adjusted independently. 

3D Volume Clipping: Click the “Enable Clipping” box to clip the image 
along the predefined anatomical planes (sagittal, axial, coronal, and arch).  
• Scrolling the mouse wheel or moving the slider moves the clipping 

plane.  
• To switch a view to the opposite side, click “Flip.”  
• Custom: This option places the clipping plane at a custom position 

and orientation. 
• Modify Custom Plane: Allows the user to modify the position 

and orientation of the clipping plane. 
 

New Volume Slices: The Opacity slider adjusts the opacity of the 
superimposed volume. The Color button changes the color of the 
superimposed volume. 

Adjust Final Stitched Image Size: This feature sets new boundaries for 
the stitched scans. If the stitched volume does not fit into the window or is 
off centered, this feature can be used to adjust the boundaries. 

Save Stitched Image File: This button saves the stitched  
volumes into an invivo file. Upon saving, the two volumes are merged and 
open as a regular Invivo file. 
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Stitching: How to Stitch Two Volumes 

Invivo provides an easy-to-use tool that combines two volumes to create a larger field-of-view scan. Although it is easy to use, it is 
a technique-sensitive feature with the most critical step being the registration of the scans by selecting stable landmarks. The next 
section shows how to stitch two scans step by step. 

Step 1. Save DICOM Files as Invivo Files.  

Both scans are recommended to be saved as Invivo files (.inv) before proceeding. See the section on Invivo File Saving for saving 
DICOM files as Invivo files.  

Step 2. Open the First Invivo File.  

Open the first Invivo file. The cases do not need to be opened in a specific order.  

Step 3. Import Volume.  

Go to the Stitching Tab. Click on the Import New File button on the Control Panel to select the second scan: 

 
 

 

Step 4. Registering the Two Scans to Each Other.  

In order to stitch the scans correctly, strict attention must be exercised in selecting at least four matching and stable landmarks in 

both scans. Use the Registration function:   
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Select the first landmark on one scan, and then select the exact matching landmark on the other scan. The landmarks are selected 
by pressing the center scroll wheel of the mouse or by the space bar on the keyboard. Each point shows up as blue or red pixels 
(above). The image can be rotated with the mouse as usual.  

Because the points are plotted on the volume, careful attention must be taken so that the brightness is not too high; otherwise, the 
point could be offset from the point intended. Clipping the scan may make the selection of the exact point easier and potentially 
more precise.  

Once at least four points are plotted and matched, click the right mouse button to register the two scans.  
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The above image is of an upper and a lower field of view. The blue outline from the second scan closely overlaps the original bone-
colored scan in the shared region. 

The following image is of two volumes imprecisely registered. The blue and orange skeletal boundaries do not line up, leading to 
the presence of double images: 
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Step 5. Making Adjustments for Precision.  

The next step is to check the cross sections for accuracy and make the necessary adjustments. The stitching is shown in 3D as well 
as in the cross sections.  

To enlarge the cross sections, use the Layout icon on the toolbar:   

 

If the stitch is not completely precise in one of the sections, the volume or the cross sections can be moved for better 

alignment using the Adjust tool:  

Each anatomical plane should be checked for precision. The cranial base should match up perfectly because it is stable; 
however, the vertebrae may not because the patient's head is usually tilted differently in each scan.  
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Step 6. Saving Final Stitched Scan 

Use the “Adjust Final Stitched Image Size” tool to set the boundaries by dragging the white handles of the bounding box. Make 
sure the entire volume range is included. 

 

When the bounding box has been adjusted to the size desired, turn off the “Adjust Final Stitched Image Size” function and click 
the Save Stitched Image File button on the bottom left. 

 This saves an Invivo file (.inv) with the two scans together as one.  
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Medical Design Studio View Features 
 
The Medical Design Studio View Tab shows the patient in three dimensional, reconstructed views and allows you 
to explore the internal structures and never-before-seen anatomy of the patient. With Medical Design Studio, you 
can create surface models of the patient and use these models to create simulations, design medical devices, etc. 
These patient-specific models can also be exported from Invivo as STL or PLY files for use in other design software 
or other files (STL, PLY, OBJ) can be imported into Invivo to verify dimensions, etc.. 
 

 

 
Warning: MD Studio module is not a medical device and should be used as a reference, educational, or presentation tool only. 
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Medical Design Studio: Toolbar 

Shown below is the Tool Bar and tools that are loaded with the MD Studio View Tab: 

 

 

 
Reset: Resets the rendering window to the original view size. 

 
Left: Automatically orients the volume in a left sagittal view. 

 
¾ Left: Automatically orients the volume in a 45° left view. 

 
Front: Automatically orients the volume in a front view. 

 
¾ Right: Automatically orients the volume in a 45° right view. 

 
Right: Automatically orients the volume in a right sagittal view. 

 
Top: Automatically orients the volume in a top-down view. 

 
Bottom: Automatically orients the volume in a bottom-up view. 

 
Back: Automatically orients the volume in a posterior view. 

 

Distance Measurement: Select this option and mark two points on the volume, and the distance appears. 
Clicking on the point and moving the cursor can modify points. Click on the measurement and press the 
“delete” key to delete it. Control Panel features allow the values to be projected to 2D, hidden, or exported 
to a report. 

 

Angle Measurement: Select this option and mark three points on the volume and the angle between them 
appears. Clicking on their control points and moving the cursor can modify measurements. Click on the 
measurement and press the “delete” key to delete it. Control Panel features allow the values to be projected 
to 2D, hidden, or exported to a report. 

 
Freehand Sculpture: Freely outline an area and remove the volume perpendicular to the plane of the 
screen. The volume inside or outside the selection can be chosen by clicking in the respective areas.  

 

Polygon Sculpture: Outline an area by placing a series of points and right-clicking. The volume 
perpendicular to the plane of the screen is removed. The volume inside or outside the selection can be 
chosen by clicking in the respective areas. 

 

Sculpt (Inverse): Allows you to invert any sculpting operations done on the volume. The entire volume 
will return with the exception of previously sculpted volume. (see Medical Design Studio: Volume 
Manipulation for more details) 

 

Volume Objects: Allows you to perform Boolean operations using basic shapes on the rendered 
volume. Shapes include a sphere, block, cylinder, triangle, path-defined pipe, and voxel. (see 
Medical Design Studio: Volume Manipulation for more details) 

 

Create Mesh Primitives: Allows you to create mesh objects of basic shapes. Shapes include a 
sphere, block, cylinder, and path-defined pipe. 

 

Select Area: Allows you to outline an area (using a series of points) on the surface mesh. “Right 
click” on your mouse to indicate you are finished adding points; MD Studio will automatically 
connect your last two points to close your area. (see Medical Design Studio: Mesh 
Manipulation for more details) 



 
 

     163 of 203                                 UM-VET-ENG-72A ANA003 Rev A  NOV 11th, 2025 PAGE 

            

 

Fill Area: After selecting an area on the surface mesh, this tool replaces this area between 
the points with a new surface mesh. Essentially “filling in holes” in the mesh. (see Medical 
Design Studio: Mesh Manipulation for more details) 

 

Flatten Area: After selecting an area on the surface mesh, this tool replaces the area between 
the points with a new surface mesh of constant height. Essentially “flattening bumps” in the 
mesh. (see Medical Design Studio: Mesh Manipulation for more details) 

 

Pull Area: After selecting an area on the surface mesh, this tool lets you push/pull the selected 
mesh area. The direction of the pull can be adjusted. (see Medical Design Studio: Mesh 
Manipulation for more details) 

 

Cut Area: After selecting an area on the surface mesh, choose to remove either the surface mesh 
area between the points or outside the points. (see Medical Design Studio: Mesh Manipulation 
for more details) 

 

Move Mesh: Allows you to translate and rotate the entire surface mesh relative to the rendered 
volume. The location and orientation of the surface mesh will be the initial position of the mesh 
when exported as a model to the Model View Tab. (see Medical Design Studio: Mesh 
Manipulation and Medical Design Studio: Control Panel – Import Export for further details) 

 

Mesh Scale: Allows you to scale the entire surface mesh either along one axis or in all directions. 
The “Model Scaling” window will open automatically and scaling is done by percentages via 
this window. (see Medical Design Studio: Mesh Manipulation for more details) 

 

Plane Cutter: This tool allows you to cut your mesh along a plane. A set of red, blue, and yellow 
axes will appear; the cutting plane is on the blue-red axes (normal to the yellow axis). Position 
your cutting plane and “right- click” to remove any surface mesh behind the plane (opposite side 
of the yellow arrowhead). (see Medical Design Studio: Mesh Manipulation for more details) 

 

Mirror Mesh: Press this button to mirror the surface mesh about the plane defined by the volume's 
head- foot axis and posterior-anterior axis. (see Medical Design Studio: Mesh Manipulation 
for more details) 

 

Register: Allows you to register points on the rendered volume. The mesh will orient itself to best 
align on the volume for faster, proper mesh orientation. (see Medical Design Studio: Mesh 
Manipulation for more details) 

 

Remove Mesh (from Volume): Opens the Remove Mesh from Volume window that allows you to boolean 
subtract a closed mesh object from the volume.  

 
Reset Volume: Any cutting operations done to the volume are undone. The volume will resume 
to its original, full shape. (see Medical Design Studio: Volume Manipulation for details) 

 

Mesh Model List: Opens/Closes the Mesh Models Edit window. The window lists details of all 
mesh objects in the current case. The Mesh Models Edit window also allows you to toggle 
visibility and delete individual mesh objects 

 Visual Preference: Change the background color in the Rendering Window. 

 Section Layout: Displays or hides three cross-section panes (axial, sagittal, coronal). 

 
Grid: Toggles between four different grid layouts for simple assessment of size, measurement, and spatial 
location. 

 
Information Display: Displays or hides case information embedded in the scan data. 
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Medical Design Studio: Control Panel  

 

Surface Model: 
• IsoValue: Set the IsoValue for the surface mesh you 

want to make. The value can be set by using the 
slidebar, clicking the up-down arrows, or typing in the 
numerical value manually.  

o Select “Full Range” to change the 
maximum/minimum IsoValues to match the 
maximum/minimum values available from the 
DICOM scan. By default, the “Full Range” 
selection should be off to limit the 
maximum/minimum values to what the 
software determines to be the most effective 
range 

• Visible: Select this to hide/show a created surface 
mesh. 

• IsoSurface: After manipulating the volume to the desired 
size/shape and choosing an IsoValue, select the Subsample 
setting value for the IsoSurface (1, 2, 4) and press Create. 
This will create an IsoSurface mesh around the volume. 
Select Smooth and MD Studio will attempt to smooth 
the created mesh automatically. (See Medical Design 
Studio: Mesh Creation for more details.) 

• Wrapping Surface: After manipulating the volume to 
the desired size/shape and choose an IsoValue, select the 
wrapping setting (Rough, Normal, Fine) and press 
Create. This will create a Wrapping Surface around the 
volume. (See Medical Design Studio: Mesh Creation 
for more details.) 

• Decimate Mesh: The “Decimate” window will open. 
Enter the desired number of triangles or reduction ratio 
(0.0~1.0) to redefine the number of triangles used to 
make the surface mesh. The current number of points 
and triangles can be found in the bottom left corner of 
the Rendering Window. 

  

• Model Property: A window will open automatically to set various visual properties of the surface mesh. You 
may set the opacity of the mesh using the slider bar. Rendering adjustments can be made as well; including 
mode selection (points, wireframe, surface) and shading options (flat, smooth). Material colors and 
coefficients are also adjustable within this window. (see Medical Design Studio: Mesh Creation for more 
details) 

 

View Control: 
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• Color Presets: Gray Scale, Inverse, Soft Tissue 1, etc. allows better visualization of certain anatomic 
structures, soft tissue profiles, airway, etc. The color rendering is only for visualization. The colors are based 
on densities but DO NOT represent the density value of the bone.  

• Opacity: Allows for the translucency/opacity to be adjusted. 
• Brightness & Contrast: Can be adjusted for each of the presets to enhance the image.  

 

Clipping: 

• Click the “Enable Clipping” box to slice the image along the predefined anatomical planes (sagittal, axial, 
coronal, and arch). 

• Scrolling the mouse wheel or slider moves the clipping plane. 
• To switch a view to the opposite side, click “Flip.” 
• Custom: This option places the clipping plane at a custom position and orientation. 

o Modify Custom Plane: Allows the user to modify the position and orientation of the clipping plane. 
 

Smoothing: 

• Smooth Selected Region: After selecting an area with the Select Area Tool (see Medical Design Studio: 
Toolbar) smooth the mesh by pressing the Smooth Selected Region button. If no area has been selected, MD 
Studio will ask to smooth the entire surface mesh. The Power can be set (5, 10, 20, 30, 50) as well as the 
Relax setting (0.1, 0.2, 0.3, 0.4, 0.5). Both will affect the amount of smoothing done on the surface. (see 
Medical Design Studio: Mesh Manipulation for more details) 

• Stroke Smooth: Press the Stroke Smooth button; move your mouse to a section on the model you wish to 
smooth; press and hold the “left button” and move your mouse along other sections of the model you want to 
smooth. The model will be highlighted with a blue mesh over areas that will be smoothed when you release 
the “left button”. The Power and Relax settings will affect the amount of smoothing done on the surface. The 
Thickness can also be set (1, 2, 5, 10) which affects the radius you want highlighted during your smoothing 
strokes. (see Medical Design Studio: Mesh Manipulation for more details) 

 

Import Export: 

• Add To Model View: Add the IsoSurface or Wrapping Surface to the model view. You will be prompted to 
give your model a name and define the object hierarchy (see image right). Adding to the Model View does 
not make an external copy of your surface mesh. Use Export Model to save an external copy. See the Section 
Model Import and Export for more information. 

• Get AnatoModel Skin: Grab the mesh defined as the “Skin” in the Model View and add it to the MD Studio 
Rendering Window. If no model is defined as the “Skin” in the Model View, you will be prompted with an 
error message and no model will be imported to the scene. 

• Export Model: Save your IsoSurface or Wrapping Surface external to the current .inv file. You may save 
your file as an STL or PLY object file for reference later. Saving to an STL or PLY does not add your surface 
mesh to the Model View. 

• Import Model: Load an external STL, PLY, or OBJ file into the Rendering Window. Doing so will replace 
any IsoSurface or Wrapping Surface you may have active. Mesh operations can be performed on this 
imported file and the imported model can be added to the Model View using the Add To Model View button. 

• For more details regarding the Import/Export feature within MD Studio, please refer to Medical Design 
Studio: Model Import and Export. 

 

Update Volume: 

• Updates the Volume in the other tabs within Invivo. Any changes to the volume in the MD Studio Tab from 
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sculpting, editing, or adding Volume Objects will be applied to the volumes through Invivo. 
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Medical Design Studio: Volume Manipulation 

By default, the volume shown in the Rendering Window is generated from the patient's DICOM data and should not be confused 
with the model/mesh created within the Medical Design Studio View. With this rendering, volume can be added or subtracted 
using the tools in MD Studio shown below: 

 

This section describes how to use the above tools and includes some example photos to clarify how the tool functions. 

 

Sculpt Tool (Free Form) 
 

By selecting the Sculpt Tool (Free Form) button in the toolbar, you can remove volume from the rendered image 
using curves drawn in the Rendering Window. 

The image below shows an example of the volume before and after the use of the Free-Form Sculpt Tool. 

 

 

The cutting line was drawn on the mandible (left) and the top part was removed by clicking the mouse on that side of the 
line. The resulting volume is shown (right). 
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Sculpt Tool (Polygon) 

By selecting the Sculpt Tool (Polygon) button in the toolbar, you can remove volume from the rendered image 
using point-to-point profiles drawn within the Rendering Window. The image below shows an example of the 
volume before and after the use of the Point-to-Point Sculpt Tool. 

 

 

 

The cutting profile was drawn using a series of points (left) and the top part was removed by clicking on that side of the 
profile line. The resulting volume loss is shown (right). 

Inverse Sculpt Tool 
 

If any sculpting operations have been performed on the volume, the Inverse Sculpt Tool will have one of the 
following effects: 

Volume was removed and Inverse Sculpt Tool is used 

The Inverse Sculpt Tool will reset the rendering to show everything except the volume currently on the 
Rendering Window. 

Ex: Mandible is separated from rest of skull. Inverse Sculpt Tool will show the full volume without the 
mandible (see image below) 
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Volume was added and Inverse Sculpt Tool is used 

The Inverse Sculpt Tool will perform a Boolean operation and output only the overlapping region of the two volumes. 

Ex: Pipe volume is added to the mandible and nothing else is done to the rendering. Inverse Sculpt Tool will 
show overlapped volume (see image below) 

 

Volume Objects Tool 
There is a set of predefined shapes that you can use to add (remove) volume to (from) the rendering. The basic 
shapes are a block, sphere, cylinder, pipe, triangle and voxel. The Volume Objects Tool performs a Boolean 
add/remove operation with the selected shape. 

 

 

Sphere: Define the diameter of the sphere and left-click on an anatomical feature to place the shape. Use the Move Widget 
to the desired location and press Apply to either add or remove the shape to/from the rendering. 
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Block: Define the length, width, and height of the block and left-click on an anatomical feature to place the shape. Use 
the Move Widget to the desired location and press Apply to either add or remove the shape to/from the rendering. 

Cylinder: Define the diameter and height of the cylinder and left-click on an anatomical feature to place the shape. Use 
the Move Widget to the desired location and press Apply to either add or remove the shape to/from the rendering. 

Pipe: Define the diameter of your pipe and using the left mouse button, place a series of points to define your pipe profile. 
Right-click when you have finished your profile. The pipe should be added to the rendering screen but the 
profile points can still be moved. Press Apply to either add or remove the shape to/from the rendering. 

Voxel: This is a term used to describe a volume element (“volumetric pixel”, “volumetric picture element”). There is no 
need to press Apply for add/removing voxels. Select a size for the voxel (1, 2, 3) and left-click anatomical 
features in the rendering window. The voxel will automatically be added or removed. 

Triangle: Define the height of the triangle and left-click on three (3) anatomical features to define the profile of the triangle. 
Press Apply to either add or remove the shape to/from the rendering. 

 

Reset Volume 
This tool allows to you completely reset the volume in the Rendering Window back to the default settings. Reset 
Volume will undo any and all operations done to the rendered volume. This does not affect any surface meshes 
made. 
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Medical Design Studio: Mesh Creation 

Medical Design Studio allows users to create surface meshes/models based on the CBCT scans of their patients. This section 
describes in further detail surface model creation and the different settings you can change to view your surface models. 
 

IsoValue 
 

The setting for the IsoValue will determine the density level 
threshold that Medical Design Studio will use when creating the 
surface mesh. A higher IsoValue corresponds to a higher 
density level and a lower IsoValue corresponds to a lower 
density level. 

 

Use the slider to set the IsoValue or enter the numbers manually. 

Ex: IsoValue setting “620” includes all densities associated with IsoValue higher than 620. The created surface 
will include higher density values (ex: cortical bone), some lower density values (ex: soft tissue, gingiva), and 
densities in between. 

By default, Medical Design Studio selects a range of IsoValues that it determines will be the most useful based on the 
imported data file. However, you can override this by selecting Full Range which adjusts the slider bar to the full range 
of possible IsoValues. 

To preview how your IsoSurface will appear, use the preset view named “IsoSurface” under Volume Control. By 
changing the IsoValue, the rendered volume will actively change within the Rendering Window. The previewed image 
does not show what the final IsoSurface mesh will look like when created and is to be used as a preview tool only. 

 

IsoSurface 

 

Select the Subsample size (1, 2, 4) to determine the accuracy that your created mesh 
will represent the surface of the rendered volume. The lower subsample setting 
corresponds to more points and triangles that will be used to represent the surface 
resulting in higher accuracy. Press the Create button to make your surface mesh model. 
Selecting Smooth will have Medical Design Studio smooth the surface of the model 
and ignore some of the noise surrounding the rendered volume surface. 

 

Examples of the different subsample settings are shown on the following page. Notice the difference in the number of points 
and triangles (bottom left corner of images). 



 
 

     172 of 203                                 UM-VET-ENG-72A ANA003 Rev A  NOV 11th, 2025 PAGE 
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Wrapping Surface 
 

Select the level of accuracy you would like your Wrapping Surface to exhibit (Rough, 
Normal, Fine) and press Create to have a Wrapping Surface represent your rendered 
volume surface. Wrapping Surface (unlike IsoSurface) attempts to create a uniform 
surface model (no gaps, holes, inner structures). As a result, it can be a little more 
sensitive to noise surrounding the rendered volume surface. However, it can produce more 
accurate representations for certain renderings. The Rough/Normal/Fine setting will 
determine how many iterations will be done to create the surface and the allowed 
deviation. 

 

The images below show the same sculpted volume modeled using an IsoSurface (subsample 1) and a Wrapping Surface 
(Fine setting). 

 

 

Decimate Mesh 
 

After creating your surface mesh model (either a Wrapping Surface or IsoSurface), you can reduce the number of 
triangles used to define it. Press the Decimate Mesh button to open up the Decimate Window. You can enter either a Target 
Number of Triangles or a Reduction Ratio. Press OK to complete the operation. 

 

 
 
 
 
 
 
 
 
 
 
 

 
Wrapping Surface - Fine 

 
 
 
 
 
 
 
 
 
 
 

 
IsoSurface - Smooth, 1 
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Model Property 
 

Pressing the Model Property button will open up the Visual Property Window where visual preferences can be adjusted. 

 

 

Visibility: 
Use the slider to adjust the Opacity of the model in the Volume Rendering Window. Uncheck the Visible selection 
to hide the model entirely (similar to hiding the model through the Control Panel button). 

Rendering: 
Mode: Sets how the model will be rendered (surface, wireframe, or points). (see images on the following page for 

examples) 

Shading: Affects how lighting reflects off your surface mesh model in the rendering window (flat or smooth). 

Smooth tends to add shadows to the rendering. 

Back Face Culling: Adjusts which surface normal will reflect light (be seen) in the rending window. When it is 
selected, surface faces will be transparent when viewed from behind. (See images on following page for 
examples) 

Material: 
You can set the ambient, diffuse, and specular colors of your model. Adjusting the coefficients affects the intensity 
of the color on your model. 
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The above image shows the various Rendering Modes under Model Property. 

 

The above image shows the effects of Back Face Culling The image on the right has the Back Face Culling option selected. 
The image on the left does not. Both images have been set to approximately 60% opacity. 

 
Changes in the surface mesh properties are shown immediately in the Rendering Window. Press OK to finish making 
changes to the surface mesh and close the “Visual Property” window. 

Points Wireframe Surface 
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Mesh Models Edit 

 Clicking on the Mesh Model List button on the toolbar opens the Mesh Models Edit window. The Mesh Models 
Edit window is populated with all mesh objects present within the current case. 

 

From the Mesh Models Edit window, visibility of mesh objects can be toggled by clicking on the checkbox to the left of 
the model. Selecting a mesh from the list also selects the mesh for editing. Multiple meshes can be selected by clicking 
on them while holding CTRL. This allows for multiple meshes to be transformed, smoothed, or scaled. 

 

 

Certain details on the mesh are shown in the Mesh Models Edit window as well. 

 

IsoValue: The IsoValue selected to create the source mesh. 

Vertex: Vertex count of the mesh. Typically the more vertices in a mesh the larger and/or more detailed the mesh object. 

Triangle: The number of triangles used to form the mesh object. 

Transformed: Whether the mesh object has been transformed. Will return Y if the mesh object has been translated or 
rotated using Mesh Move. 

Scaled: Whether the mesh object has been scaled. Will return Y if the mesh object has been scaled with Mesh Scale. 

Smoothed: Whether the mesh object has been smoothed. Will return Y if the mesh object has been smoothed with 
Smooth Selected Region or Stroke Smooth. 

Decimated: Whether the mesh object has been decimated. Will return Y if the mesh object has been decimated with 
Decimate Mesh. 
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Create Mesh Primitives Tool 

 There is a set of predefined shapes that you can use to add a new mesh in MDStudio. The basic shapes are a block, 
sphere, cylinder, and path-defined pipe. Meshes placed in with the Create Mesh Primitives tool will be shown in the Mesh 
Models Edit window. 

 

Sphere: Define the diameter of the sphere and left-click on an anatomical feature to place the shape. Use the Move 
Widget to the desired location and press Apply to commit the mesh object placement. 

Block: Define the length, width, and height of the block and left-click on an anatomical feature to place the shape. 

Use the Move Widget to the desired location and press Apply to commit the mesh object placement. 

Cylinder: Define the diameter and height of the cylinder and left-click on an anatomical feature to place the shape. 

Use the Move Widget to the desired location and press Apply to commit the mesh object placement. 

Pipe: Define the diameter of your pipe and using the left mouse button, place a series of points to define your pipe profile. 
Right-click when you have finished your profile. The pipe should be added to the rendering screen but the 
profile points can still be moved. Press Apply to commit the mesh object placement. 
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Medical Design Studio: Mesh Manipulation  

In addition to creating surface models, Medical Design Studio allows you to edit your imported or created models using the 
basic surface mesh operating tools shown below: 
 

 

This section discusses in greater detail how to use these mesh manipulation tools and includes photos showing how the tools 
operate. 

 

Select Area Tool 
By selecting a series of points, you can define an area on your surface model. Use the right-click after placing your 
last point and the software will automatically close the loop and create your area. The image below shows an 
example of selecting an area. 

The points defining the profile must be on the surface boundary of the mesh 
otherwise a point will not be placed. When the area has been selected, the placed 
points can still be moved to better encompass specific features as you see fit. 

It is important to properly define your area as it is the first step in using the 
following tools: 

• Mesh Area Filling 
• Mesh Area Flattening 
• Mesh Area Pulling 
• Mesh Area Cutting 
• Smooth Selected Region 
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Mesh Area Filling 
Select an area with the Select Area Tool and fill in gaps for a smoother looking model. See the following pictures 
as an example. Note: try to adjust the IsoValue first to fix gaps before resorting to the Mesh Area Filling Tool. 

 

 

The above images show the effect of the Mesh Area Filling Tool. 
 

 

 

Mesh Area Flattening 
Select an area with the Select Area Tool and flatten features for a smoother looking model. See the following 
pictures as an example. Note: try to adjust the IsoValue first before resorting to the Mesh Area Flattening Tool. 

 

 

The above images show the effect of the Mesh Area Flattening Tool. 
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Mesh Area Pulling 
Select an area with the Select Area Tool and pull the area to customize the model. The direction of the pull can be 
adjusted using the rotation widget that appears. The selected area can also be pushed using the same tool. 

 

The above images show the effect of the Mesh Area Pulling Tool. 

Mesh Area Cut 
Select an area with the Select Area Tool and cut the area to edit the 
model. You will be prompted whether to keep or remove the area 
within the selected profile (shown below). Examples of Mesh Area 

Cut Tool effects on following page. 

 

 

 

 

 

The above images show the effect of the Mesh Area Cut Tool – keeping the inside. 
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The above images show the effect of the Mesh Area Cut Tool – keeping the outside. 
 

Mesh Move 
You can move and rotate the model relative to the original rendered volume. You can change the rotation point 
by holding down the CTRL button to move the coordinate axes relative to the surface model. The orientation 
and location of this surface model will determine its orientation and location in the Model Tab View. (see Medical 
Design Studio: Model Import and Export). This function allows multiple models to be moved together by 
selecting them first in the rendering window or Mesh Models List. 

 

The above images show the effect of the Mesh Move Tool. 
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Mesh Scale 
You can scale the size of the created mesh using the Model Scaling Window. You can grow or shrink your surface 
model by 1% increments or by applying a percent scaling. Using the Scaling Widget, you can choose along 
which axis you wish to scale your surface model. If All Direction is selected in the Model Scaling Window, 
MD Studio will apply your scaling transformation along all axes. This function allows multiple models to be 
scaled together by selecting them first in the rendering window or Mesh Models List. 

 

Plane Cutter 
You can remove part of your surface mesh model using the Plane Cutter Tool. The cutting plane can be moved 
and rotated using the Plane Cutter Move Widget. The Plane Cutter will remove any portion of your mesh model 
behind the yellow arrow (see images below). 

Note: plane cutting operations will affect the mesh only; the rendered volume will remain the same. Similarly, 
enabling “clipping” will not prevent the mesh from being cut like it does for the volume. Even though the volume and mesh 
may be hidden from view, the Plane Cutter will still remove any portion of the surface mesh model that is behind the 
yellow arrow. 

 

 

The above images show the effect of the Plane Cutter Tool. 
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Mirror Mesh 
You can mirror your created surface mesh model about the rendered volume's midsagittal plane as defined in the 
Section Tab (green line/plane). The mirrored mesh will replace your original creation. All mesh manipulation 
tools can be operated on the mirrored mesh. 

 

 

The above images show the effect of the Mirror Mesh Tool. (Note the asymmetry between the zygoma.) 

 

Mesh Registration 
This tool assists in aligning an existing surface mesh model (either created or imported) with the rendered 
volume. After selecting this tool, select points on the rendered volume. Right-click to finish and MD Studio will 
register the mesh to these points on the volume. Some final movement/rotation may be necessary to move mesh 
into an exact location and orientation using the Mesh Move Tool. 

 

 

The above images show the effect of the Mesh Registration Tool. The red dots are the registration points chosen for the 
mesh. 

 

In addition to the manipulation tools in the Toolbar, Medical Design Studio allows 
you to smooth your surface mesh models (created or imported) using its own 
smoothing operation tools. This section covers these smoothing operation 
tools (Stroke Smooth and Smooth Selected Region) in greater detail. 
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Smooth Settings 
The smoothing operation tools function by selecting an area on the mesh and averaging the positions of the individual 
points that compose the mesh. By adjusting the following settings, you can adjust how little or how much smoothing will 
be performed on your mesh. 

Power: Sets the number of averaging iterations (5, 10, 20, 30, 50). A larger power setting corresponds to a more 
noticeable smoothing operation. The images at the the bottom of the page show the difference between the 10 and 50 
settings. 

Relax: Sets the distribution of triangles along the surface mesh model (0.1, 0.2, 0.3, 0.4, 0.5). Larger relax settings 
will result in smoother surfaces but could omit key surface features. 

In general it is recommended that you use a small relax setting and large power setting when performing smoothing 
operations on your surface mesh models. 

 

 

 

Smooth Selected Region 
Use the Select Area Tool to define an area on your surface mesh model (created or imported) on which you want to 
perform your smoothing operation. Set the desired Power and Relax settings and press Smooth Selected Region. The 
Smooth Selected Region button can be pressed multiple times for the same selected area to perform the smoothing 
operation repetitively. The images on the previous page (33) show the effects of using the Smooth Selected Region 
operation tool on a selected area. 

If no area has been selected, Medical Design Studio will ask to smooth the entire model surface at the set Power and Relax 
settings. 

No smoothing Power = 10 Power = 50 
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Stroke Smooth 
The Stroke Smooth operation tool does not require a selected area on the model to be selected before being used. Set your 
desired Power and Relax settings and press the Stroke Smooth button. Next, you will highlight an area on the surface you 
wish to smooth by pressing and holding the left-button on your mouse. When you release your mouse, the highlighted 
area will be smoothed at the set Power and Relax settings. 

Thickness determines the area around your mouse when highlighting the surface of your model (1, 2, 5, 10). The image 
below shows the difference between two Thickness settings. 
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Section Layout 

 Toggling on the Section Layout button on the Toolbar shows/hides three section panes that appear on the left of 
the rendering window. These panes can be navigated in a way similar to the Section Tab. The top pane corresponds to 
an Axial slice, the center pane a Sagittal slice, and the bottom pane a Coronal slice. The mouse wheel can be used to scroll 
through slices, and the cursor on each slice pane can be dragged to quickly move to a desired point of interest. Orange, 
green, and blue rectangles will also surround the volume in the render window. These correspond to the current location 
of the axial, sagittal, and coronal slice planes respectively. 

Mesh objects are also visible on the section panes as well, represented in the same color as it is on the render window. 

 

 

The Section Layout view allows for quick slice cross referencing during mesh and volume editting. 

Opening the Section Layout will also activate the Pointer Coordinates section of the Control Panel. 

 

Pointer Coordinates 
 

The pointer coordinates refer to the XYZ and IJK 
coordinates of the current location of the mouse cursor 
within the Section Layout. Therefore, it will only reflect 
the position of the cursor in the grayscale renderers and 
not in the 3D rendering window. 

 

Mesh Delete 
To delete a mesh or multiple meshes at once, first select the mesh in the rendering window or Mesh Model list by left-
clicking the model or the name of the model, respectively, until the dotted red bounding box appears around the desired 
model or models. Once selected, press the Delete key on the keyboard or the Delete button in the Mesh Model List to 
delete. The program will prompt the user to make sure they want the model to be deleted. 
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This image shows multiple models selected within the rendering window, which allows to simultaneous deletion, scaling, 
or transformation. 
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Medical Design Studio: Model Import and Export 

MD Studio lets you create and edit models within the Rendering Window but it also allows you to export these models as 
standard STL and PLY files to use in other design software as you see necessary. Furthermore, you can import STL, PLY 
and OBJ files from other design software to edit within the Medical Design Studio View Tab. 
This section discusses the basic steps to export a file from (or import a file to) MD Studio. It also covers how to add your 
models to the Model View for simulation and video capture. The models will also be visible in the Superimposition and 3D 
Analysis tabs for further clinical analysis. 

 

 

Add to Model View 
After you have defined your surface mesh model (creating your own or 
importing), you can add this model to the Model View Tab. In the Model 
View Tab, multiple surface mesh models can be visible within the 
Rendering Window which allows movement simulations. 

When adding a model to the Model View, you need to define the model 
heirarchy in a new window (see right). When adding to the Model View, the 
location/orientation of the mesh model relative to the rendered volume 
will be the same location/orientation in the Model View. 

 

Add as Deformable Skin 
Add your model to the Model View as a surface that is deformable. 
Typically this is done for models that will serve as the facial soft-tissue 
which can change based on Invivo's Soft-Tissue Prediction algorithms. 
There can only be up to one (1) Deformable Skin defined. (refer to the 
Invivo5 Reference Manual for more information). 

 

Add as Child of Selected Obj 
Highlight a model (the “Parent Model”) already added to the Model View. Pressing Add as Child of Selected Obj will 
make your current model (the “Child Model”) dependent upon the motion of the Parent Model. In the Model View, any 
translation/rotation performed on the Parent Model will also be performed on the Child Model. Any translation/rotation 
performed on the Child Model will not be performed on the Parent Model. 

 

To add a model to the Model View without having it dependent upon existing models, select Scene Root as the Parent 
Model. 

Before adding the Child Model to the Model View, you will need to give it a unique name and choose under which type the 
model will be categorized (Generic, Bone, Tooth Segment). 
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● Generic: model is added to Model View and will not interact 
with the soft-tissue 

● Bone: model is added to Model View and will affect soft- 
tissue for prediction(s) 

● Tooth: model is added to Model View and will affect soft- 
tissue for prediction(s) 

● Segment: in Model View, mesh will remove volume from 
rendering when selected. This works well with Wrapping 
Surfaces and may not show the ideal responses using 
IsoSurface mesh models. 

 

Add Sculptured Volume Object 
Current sculpted volume will be added to the Model View. Volume render control settings such as Brightness/Contrast, 
Teeth/Bone renders can be applied individually to sculptured Volume Objects in the Model View. Simulations in the 
Model tab can be applied to the sculptured volume Object as well. 

 

Delete Selected Obj 
Highlight a model already added to the Model View. Press the Delete Selected Obj button and the highlighted model 
will be removed. 

 

Change Parent of Selected Obj 
Highlight a model already added to the Model View that you want to make a Child Model. The model can be either a Parent 
or Child Model initially. Press the Change Parent of Selected Obj button to open a new window and choose another 
model to be the Parent Model. 

The following pages contains step-by-step instructions and sample images on adding your model to the Model View Tab. 
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Example 1: Adding a Dependent (“Child”) Model 

● Create/import a new model (set of teeth 
shown in image) 

● Select existing model (Mandible) and press 
Add as Child of Selected Obj 

● Give the model a name and category and press 
OK. 

● In the Model View Tab (images below) the 
teeth move with the mandible. 

● Teeth can move independently of the 
mandible if selected. 

 

 

 

MD Studio Tab 

Model View Model View 

Model View 
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Example 2: Adding an Independent Model 

● Create/import a new model (maxilla shown in image) 
● Select Scene Root and press Add as Child of Selected Obj 
● Model will be added to Model View independent of other models (Mandible, Tooth) 

 

 

Example 3: Adding a Sculptured Volume Object 

● Sculpt a desired volume with the freehand/polygon sculpting tool 
● Click Add to Model View, then select a target (Scene Root) 
● Click Add Sculptured Volume Object 

MD Studio Tab 

Model View 
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● Model will be added to Model View independent of other models (Mandible, Tooth) 

 

Volume objects differ from 
models in that volume objects are 
composed of voxels rather than a 
point cloud and mesh. With 
accompanying scalar value data, 
a volume object better preserves 
the detail of internal structures 
compared to a mesh model which 
typically only encapsulates the 
external surface. Volume objects 
however will require more 
system resources to render. 

Image on the right: The mandible 
was segmented away from the 
rest of the skull in MDStudio and 
then added as a Sculptured 
Volume Object 

 

 

 

 

 

 

 

Get AnatoModel Skin 
 

If a Deformable Skin has been defined and already added to the Model View, you can retrieve that Deformable Skin 
and import it into the Medical Design Studio for mesh manipulation. Press the Get AnatoModel Skin button and 
Invivo will add the Deformable Skin to the Rendering Window withing Medical Design Studio. 

If no Deformable Skin has been defined in Model View, nothing will be imported into Medical Design Studio from 
the Model View. 

 

Export Model 

 

Press the Export Model button to save your surface mesh model as a PLY or STL file. In the window that 
opens, browse to where you want your file saved; choose what type of file you would like to save; and finally, give 
your file a unique name 

 

Import Model 
 

Press the Import Model button to import a surface mesh model (PLY, STL or OBJ files). Browse in the new 
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window to find your file that you want added to the Rendering Window within Medical Design Studio. OBJ 
files can be imported and BMP image files can be associated to give a textured look to the model. 

 

Update Volume 

 

 

Press the Update Volume button to commit changes made to the volume in the MD Studio tab to be reflected 
throughout all tabs of Invivo. These changes will take effect after the case is saved and reopened and apply to both 
2D slice images and 3D volume renderings. Note that saved changes made with the Update Volume button are 
permanent; pressing Undo in the Volume Render tab will not replace the data that has been sculpted away. 
Likewise, the Reset Volume button in the toolbar will not reset the volume to its initial state and will instead reset 
to the state of the most recent Update Volume commit. 
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Invivo Software Troubleshooting 

Category Error Solution 

General Error Message: 
InvivoVet Application has encountered a problem and needs to close. We 
are sorry for the inconvenience. 
 

 Click the “Don't Send” button. 
 Check if there are old versions of optional plug-ins: remove 

them or upgrade them to be compatible with InvivoVet. 
 Launch the InvivoVet application again. 

Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Cannot launch InvivoVet  Open Task Manager and check if multiple instances of 
InvivoVet are already running. 

 Close other InvivoVet processes. 
 Launch the InvivoVet application again. 

Computer failure Launch the InvivoVet application again. 
Warning: Treatment information can only be manually saved. 
All information added after last saving will be lost. 

Installation Error Message: 
Server is not Responding 

 Check Internet connection. 
 If Internet is connected, try again later. 

Error Message: 
Please run as administrator to activate software 

Run the installer/application as administrator. 

Error Message: 
Administrative access is required to update the application. If you are an 
administrator, please relaunch the software by right-clicking on the 
application Icon and select-ing “Run as Administrator” 

Run the application as an administrator to update the software 
using Auto-Update 

Error Message: 
To check for updates please connect to the internet 

To check for updates, please connect to the internet 

Error Message: 
You must be signed in to your Invivo Work-space account to download a 
software update 

To download updates, please connect to the internet 

Error Message: 
Failed to verify the license code! 

Check the license code and try again. 
Check Internet connection and try again. 

Error Message: 
Wrong License Code! 

Check the license code and try again. 

Error Message: 
Invalid Authorization code 

Check the license code and try again. 

Error Message: 
Actual size of the image can't fit to the paper size! 

Change printer setting or create an image with smaller size. 
 

Licensing Error Message: 
Number of allowed activation's exceeded. Please logout of any other 
sessions. For help please contact your administrator, or contact support 
for help by phone (408) 333-3484 or email Support@osteoidinc.com 

You can only have Invivo opened on a certain amount of 
computers at the same time, depending on the number of 
licenses you have. (Example: If you have 3 licenses, you have 
Invivo open up to 3 computers at the same time). Deactivate 
licenses by signing out of an Invivo instance, or by managing 
your licenses in Invivo Workspace. 

Error Message: 
There is no valid license code associated to this Invivo Workspace 
account. Please login with another account, contact your administrator, 
or contact support for help by phone (408) 333-3484 or email Sup-
port@osteoidinc.com. 

The account you logged in with does not have a license of 
Invivo. Please check you are using the correct login or contact 
Support. 

Error Message: 
Invivo requires access to the internet to activate the software. Please 
contact support for help by phone (408) 333-3484 or email 
Support@osteoidinc.com 

You must be connected to the internet to license Invivo. 
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Or  
Please connect to the internet to Sign out of your Invivo WORKSPACE 
Account 

Error Message: 
Invivo requires access to the internet to function properly. Please connect 
to the in-ternet within XX hours or the software will be disabled. If you 
cannot reconnect to the internet with in the allotted time please con-tact 
support for help by phone (408) 333-3484 or email 
Support@osteoidinc.com 

Invivo requires a constant connection to the internet. Once 
disconnected, you have until the allotted time in the error 
message to reconnect before you can no longer use Invivo 
during this session. 

Error Message: 
Your License has been remotely deactivated from this machine 

This occurs if you have deactivated your license remotely using 
Invivo Workspace, or if you logged into Invivo on another 
computer with an Invivo One plan. This may also occur if you 
signed out of an instance of Invivo on your computer, but still 
have another instance open. 

File Operations Error Message: 
Failed to create process. Please close other applications and try again. 

 Close all the other applications. 
 Launch the InvivoVet application again. 

Error Message: 
Error: Unknown file format! 

Check if this file is supported by InvivoVet. 

Error Message: 
Not enough memory 

 Close all the other applications. 
 Launch the InvivoVet application again. 

Error Message: 
Can't create temporary save file! 

Check if the remaining disk capacity for the temporary folder 
is big enough. 

Error Message: 
Failed to read DICOM file! 

Check if this file is supported by InvivoVet. 

Error Message: 
Can't read Dicom’s Image Data! 

Check if this file is supported by InvivoVet. 

Try to open a file but nothing showing up Check if this file is supported by InvivoVet. 

Error Message: 
Cannot save file! 

 Check if the file is the correct type. 
Check if the file path is correct and folder is writable. 

Image is distorted  Switch to another view and switch back. 

Warning Message: 
3D reconstruction may not work! 

 Check if the DICOM files are exported correctly. 

 
For all other issues, please contact Osteoid Inc. Customer Support at (408) 333-3484. 
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Keyboard Shortcuts 
The following keyboard shortcuts are available:  

 Hotkey Description 

2D Section  / Section P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
notation/measurement 

3D Section / Volume Render 0 Changes to Gray Scale rendering 

 1 Changes to Inverse rendering 

 2 Changes to Soft Tissue 1 rendering 

 3 Changes to Soft Tissue 2 rendering 

 4 Changes to Soft Tissue+Bone 
rendering 

 5 Changes to Soft Tissue+Teeth 
rendering 

 6 Changes to Bone rendering 

 7 Changes to Teeth rendering 

 8 Changes to Custom rendering 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 H Volume is clipped along the arch 

 F Volume clipping is flipped 
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 Q Enables Freehand Volume Sculpting 
tool 

 W Enables Polygon Sculpture tool 

 Delete Deletes the selected 
measurement/notation/airway 

ArchSection Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Up Arrow/Down Arrow Scrolls through selected slice 

 Delete Deletes the selected 
measurement/notation/nerve 

3D Pano / Super Pano P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 0 Changes to Gray Scale rendering 

 1 Changes to Enhanced Gray rendering 

 2 Changes to Soft Tissue+Teeth 
rendering 

 3 Changes to Soft Tissue+Bone 
rendering 

 4 Changes to Composite 1 rendering 

 5 Changes to Composite 2 rendering 

 6 Changes to Bone 1 rendering 

 7 Changes to Bone 2 rendering 

 8 Changes to Teeth 1 rendering 

 9 Changes to Teeth 2 rendering 

 Delete Deletes the selected measurement 

2D Pano / Super Ceph 0 Changes to X-ray rendering 

 1 Changes to X-ray + Soft Tissue 
rendering 
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 2 Changes to Bone Preset 1 rendering 

 3 Changes to Bone Preset 2 rendering 

 4 Changes to Bone Preset 3 rendering 

 5 Changes to Soft + Bone 1 rendering 

 6 Changes to Soft + Bone 2 rendering 

 7 Changes to MIP rendering 

 Delete Deletes the selected measurement 

Airway P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
measurement/notation/airway 

Endo 0 Changes to Teeth rendering 

 1 Changes to Pulp rendering 

 2 Changes to Bone rendering 

 3 Changes to Gradient Edges 

 4 Changes to Inverse 1 

 5 Changes to Inverse 2 

 P Volume clipping is toggled on/off 

 Q Enables Freehand Volume Sculpting 
tool 

 W Enables Polygon Sculpture tool 

 Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
measurement/notations 
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TMJ Ctrl + C/Ctrl + V Copy/Paste the selected notation 

 Delete Deletes the selected 
measurement/notations 

Superimposition P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 Delete Deletes the selected measurement 

Model P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 H Volume is clipped along the arch 

 F Volume clipping is flipped 

 Delete Deletes the selected 
measurement/notation 

Medical Design Studio 0 Changes to Gray Scale 

 1 Changes to Inverse 

 2 Changes to Bone 

 3 Changes to Teeth 

 4 Changes to IsoSurface 

 P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 H Volume is clipped along the arch 

 F Volume clipping is flipped 
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 L Changes Layout when a superimposed 
volume exists 

 Q Enables Freehand Volume Sculpting 
tool 

 W Enables Polygon Sculpture tool 

 Delete Deletes the selected measurement 

Report D Deletes page 

 E Bring up Edit Phrases dialog box 

 R Adds page 

 P Go to previous page 

 N Go to next page 

 Delete Deletes the selected box 

Stitching P Volume clipping is toggled on/off 

 A Volume is clipped axially 

 S Volume is clipped sagittally 

 C Volume is clipped coronally 

 F Volume clipping is flipped 

 R Resets view per adjustment 
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Index 
This comprehensive list provides a quick and easy way to find the relevant information as desired. 

 
3D Landmark Point ............................................................................................................................44, 114 
Airway Measurement .................................................................................................................. 87, 88, 130 
AnatoModel ............................................................................................................................................ 131 
Arch Section View Tab ............................................................................................................................. 73 
Arch Spline ................................................................................................................. 70, 71, 72, 74, 78, 97 
Brightness & Contrast ............................................................................. 46, 59, 67, 71, 76, 84, 92, 99, 165 
Case Information ....................................................................................................................................... 36 
Clipping......................................................................................................................................46, 105, 116 
Color Presets ....................................................................................................................................... 76, 99 
Comments ................................................................................................. 45, 46, 70, 82, 90, 103, 122, 126 
Control Panel .....................................20, 46, 59, 67, 71, 76, 84, 92, 99, 105, 116, 122, 135, 136, 155, 164 
Custom Projection ......................................................................................................................... 59, 84, 92 
Custom Section ................................................................................................................................... 59, 84 
DICOM ....................................................................................................................................... 28, 30, 127 
DICOM & Invivo File Loading ................................................................................................................ 28 
Export Image ........................................................................................................................................... 127 
Gallery View Tab .................................................................................................................................... 121 
Grid ..........................................................................................................45, 66, 70, 97, 103, 114, 154, 163 
Image Capture ..................................................................................................................................... 36, 37 
Image Info ........................................................................................................................................... 60, 84 
Import Image ........................................................................................................................................... 122 
Invivo File Saving ..................................................................................................................................... 30 
Keyboard Shortcuts ......................................................................................................................... 138, 196 
Layout ................................................................................................57, 64, 74, 90, 97, 101, 116, 154, 159 
License types ..............................................................................................................................................11 
Life Size ................................................................................................................................ 67, 76, 99, 129 
Measurements ............................................................................44, 46, 57, 66, 70, 74, 82, 90, 97, 103, 114 
Menu Bar .................................................................................................................................................. 20 
Model View Tab .......................................................................................................................................113 
Mouse Navigation Tools ................................................................................... 40, 61, 78, 86, 93, 100, 137 
Move Widget ....................................................................................................103, 109, 117, 120, 131, 154 
Nerve ..............................................................................................................................77, 79, 80, 116, 128 
odata .................................................................................................................................................106, 112 
PACS ......................................................................................................................................................... 31 
Panoramics .................................................................................................................................... 69, 72, 78 
Patient Info .......................................................................45, 57, 66, 70, 74, 83, 91, 97, 103, 114, 154, 163 
Patient Orientation .................................................................................................................. 53, 62, 67, 76 
Photowrapping .................................................................................................................117, 171, 178, 188 
Pixel Values ......................................................................................................................................... 60, 84 
Quick Measurement .................................................................................................................................. 45 
Registration ..............................................................................................................103, 107, 110, 154, 156 
Rendering Methods ................................................................................................................................... 46 
Rendering Window ................................................................................................................................... 20 
Report PDF ............................................................................................................................................. 135 



 

     202 of 203                                 UM-VET-ENG-72A ANA003 Rev A  NOV 11th, 2025 PAGE 

OSTEOID®
 – DEFINING THE NEXT PHASE OF 3D DENTAL AND MEDICAL IMAGING 

Report View Tab ..................................................................................................................................... 134 
Reset Zoom ......................................................................44, 57, 66, 70, 74, 82, 90, 97, 103, 114, 154, 162 
Sculpt (Free Form) ...................................................................................................................... 44, 90, 162 
Sculpt (Point-to-Point) ................................................................................................................ 44, 90, 162 
Section View Tab ...................................................................................................................................... 56 
Simulation ........................................................................................................................................116, 131 
Software Layout ........................................................................................................................................ 20 
Stitching View Tab .................................................................................................................................. 153 
Stone Model .............................................................................................................................................116 
Super Ceph View Tab................................................................................................................................ 65 
Super Pano View Tab ................................................................................................................................ 69 
Superimposition ...................................................................................................................................... 102 
Superimposition Adjustment ....................................................................................................................110 
Superimposition View Tab ...................................................................................................................... 102 
Template .................................................................................................................................. 135, 136, 150 
TMJ View Tab ..................................................................................................................................... 89, 96 
Toolbar .......................................................20, 44, 57, 66, 70, 74, 82, 90, 97, 103, 114, 122, 135, 154, 162 
Tru-Pan ................................................................................................................................................ 71, 76 
vdata .................................................................................................................................................106, 112 
View Sequence .............................................................................................45, 55, 58, 74, 83, 97, 114, 132 
View Settings ............................................................................................................................................ 22 
View Setup ................................................................................................................................................ 45 
View Tabs .................................................................................................................................................. 20 
Volume Registration .........................................................................................................................103, 110 
Volume Render View Tab ................................................................................................................... 43, 81 
Volumetric Measurement .................................................................................................................... 44, 54 
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InvivoVet 7.2 
InvivoVet is a software application used for the display and 3D visualization of veterinary imaging files from 
scanning devices, such as CT, MRI, or 3D Ultrasound. It is intended for use by veterinarians, radiologists, and 
other qualified individuals to retrieve, process, render, review, store, print, assist in diagnosis and distribute 
veterinary imaging files. 
 

• InvivoVet is not a medical device under EU MDR 2017/745, FDA 21 CFR 801.3, or any equivalent 
human medical-use regulations. 

• InvivoVet is not intended for human diagnostic or therapeutic purposes. 
• The software does not perform automatic diagnosis, nor does it replace the professional judgment of a 

licensed veterinarian 
 

       

 
US :  Nov. 2025 

 
https://learn.osteoidinc.com/invivovet-user-
manual 
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